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CHAPTER 1

GENERAL 

1.1 NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL 

This manual is intended to be a guidance manual, providing Engineers and Technicians guidance in current 
Structures Management Unit (SMU) practice using OpenBridge software.  To preserve the autonomy of 
Engineers and Technicians and encourage the application of new ideas and advancements in the technology, this 
manual does not attempt to address all possible scenarios that may arise in the use of OpenBridge software in the 
design and of modeling highway structures. It is assumed that many of these guidelines contained within will 
necessarily continue to evolve as the software continues to evolve. 

The users of this manual are encouraged to present ideas that may vary from those contained herein. These 
suggestions will be considered and implemented as deemed appropriate. 

This manual does not attempt to reproduce information that is adequately addressed in the Bentley training 
documents and/or their other publications.      

Users should also reference the NCDOT CADD Manual. 

1.2 NCDOT MIGRATION PLAN

In July of 2021, North Carolina Department of Transportation (NCDOT) started the process of migrating its 
computer-aided design and drafting (CADD) software from Bentley MicroStation V8i and Geopak to Bentley 
OpenX. OpenX is a comprehensive multi-discipline three-dimensional (3D) modeling application that can be 
used in the delivery of projects from concept through construction.   

To transition to ORD, NCDOT developed a Migration Plan with milestone activities and associated targets for 
each Unit within NCDOT to utilize OpenX in the production of designs and plans for new projects.  In July of 
2021, SMU converted projects that were less than 75% complete in v8 to OpenX.  In January of 2022, SMU 
transitioned all projects to OpenBridge. In August of 2023, the Director of Technical Services issued a 
memorandum requiring all new projects begin in OpenX (https://connect.ncdot.gov/projects/Project-
Management/Documents/08-02-2023%20NCDOT_OpenX_Migration.pdf)    

https://connect.ncdot.gov/projects/Project-Management/Documents/08-02-2023%20NCDOT_OpenX_Migration.pdf
https://connect.ncdot.gov/projects/Project-Management/Documents/08-02-2023%20NCDOT_OpenX_Migration.pdf
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1.2.1 Structures Management Unit Migration Plan

Under NCDOT’s Migration Plan, each Unit has unique activities and associated targets as part of their migration 
plan.  SMU has a three-phase migration plan for transitioning to the use of Bentley OpenBridge Designer (OBD), 
the transportation structural component of ORD. 

SMU’s three-phase migration plan is as follows:

• Phase 1 – Transition Staff and Consultants to the use of OBD for 2D plan production.   
• Phase 2 – Transition Staff and Consultants to producing 3D models to be used in reference with other 

Unit’s models and to create 2D plans. 
• Phase 3 – Transition Staff and Consultants to producing 3D models for complete digital delivery.

1.3 V8 FILE CONVERSIONS AND EXPECTATIONS

For projects with files still in MicroStation format, these files will need to be converted to OpenBridge format.  
This section is intended to provide guidance and expectations for those project files.   

1.3.1 DGN Migration Expectations

V8 files can be opened in the OpenBridge software without loss of data.  When a V8 file is opened in 
OpenBridge, a message will appear asking if the user would like to update the file.  Accept the update to convert 
the drawing to the OpenBridge format.  When a drawing is converted, the V8 levels, attributes, and format will 
be brought forward in the updated file, however these attributes will not be converted to match the Structure 
Management Unit’s (SMU) OpenBridge workspace.  Once updated to OpenBridge, there is no need to change the 
text and line styles to the new OpenBridge format or move to the use of sheet models.  Note, because the V8 
attributes have not been updated to the OpenBridge workspace, text fonts will appear different from the text 
displayed in the OpenBridge drawings.  If no modifications to the drawing content are required, the drawing may 
be printed (on paper or PDF) as usual.

Modifying Converted v8 Drawings 

When V8 drawings are converted to OpenBridge and a note or dimension needs to be added, copy and paste 
existing text then edit the new note or dimension.  If a drawing detail needs modification, the user should proceed 
as usual.  Note if new lines are placed in the drawing, their naming convention will utilize the OpenBridge 
workspace and will appear the same as the existing lines when printed.  
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Adding Drawings to a Plan Set

When additional drawings are needed for an existing plan set, use OpenBridge to develop the new drawings and 
save them as separate files using SMU’s file naming convention.  These drawings will utilize the OpenBridge 
workspace and the text will appear different from the converted or modified drawings.  During the OpenBridge 
transition period, SMU plan sets with differing text fonts will be acceptable.  

Standard Drawings and Standard Plans

SMU’s Standard Drawings and Plans have been converted to the OpenBridge format using the procedures 
described above.  The Standards will not be updated for consistency with the OpenBridge workspace until 
revisions to the content are required.  During plan development, always use standard drawings and plans 
available on SMU website.

1.3.2 DGN Plan Conversion

V8 files can be opened in the OpenBridge software without loss of data.  When a V8 file is opened in 
OpenBridge, the following message will appear:

 

Click “Open” and the file will be migrated to the current SMU workspace. The file will now be in the SMU 
OpenBridge workspace with the old v8 line styles, text styles, borders, and features.   

1.3.3 GEOPAK File Incorporation 

Projects that originated in V8i and Geopak can be incorporated into OpenBridge Designer files by importing the 
geometry (.gdk files) and terrain (.tin files).   

To incorporate an alignment from projects that used older versions of MicroStation and Geopak, take the 
following steps:

1st Locate the gpk file from the previous project and make a copy. Save the copy in your OBD project folder. 
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2nd Create an OBD “Model” file in your project folder. 

3rd In the “Model” file, click on the “Import” icon and drop down to “Geometry”.  

4th Locate the saved copy of the gpk file from step 1.   

5th Select the alignment and feature definitions for the alignment. Select each alignment and its profile one at a 
time and assign the correct features for each one. This will require repeating this step for each alignment needed 
for your project.  
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1.3.3.1 Set Feature Definition Tool

If you didn’t check the “Assign Feature Definition” box, take the following steps:

Select the correct alignment for your 
structure. 

Select the “Set Feature Definition” 
tool, under the “Standards” icon on 
the “Civil” tab. 

Select the alignment profile. 

Select if the alignment is proposed or 
existing 

Select point features as “point”. 
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1.3.4 Adding the Terrain 

To incorporate a terrain from projects that used older versions of MicroStation and Geopak, take the following 
steps:

1st Locate the .tin file from the previous project and make a copy. Save the copy in your OBD project folder. 

2nd Click on the “Import” icon and drop down to “Terrain”.  

Select the features for the alignment 
selected above. 

Use the curser to select the alignment 
to set feature definition.  
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3rd Locate the saved .tin file from Step 1.  
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4Th Click on “Import” 

Projection Targets should be 
set from the seed file.

Select “ET_Triangles”  

Leave File Units as “Unknown”  

Select “Import Both”  
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1.4 WORKSPACE

Bentley OpenX is NCDOT’s only authorized CADD software platform. OpenBridge Designer (OBD) is the 
structural operating system of Bentley’s OpenX Design products.  OBD is compatible with OpenX allowing for 
structures to be built on top of referenced OpenX files and includes Bentley’s LEAP design software package. 

1.4.1 Consultants

As part of NCDOT’s transition to project file storage on ProjectWise, Structures Management’s OBD workspace 
is incorporated into a managed workspace in ProjectWise. 

Consultants can find ProjectWise guidance documents for creating, saving, searching and exporting documents 
can be found here:

https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx.

Consultants can find the latest software version of OpenBridge being used by the Department here:

https://connect.ncdot.gov/resources/CADD/CADD Documents/NCDOT CADD Software Versions.pdf 

1.4.2 SMU Workspace

Similar to previous versions of MicroStation, in an effort to maintain consistency amongst contract plans and 
now 3D models Structures Management will continue to produce and maintain a custom workspace for OBD in 
the NCDOT Unified WorkSpace.    

OpenBridge uses element templates, level names, feature symbology and feature definitions.  The current 
workspace has new workspace properties and will continue to evolve with 3D templates and libraries.  

https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx
https://connect.ncdot.gov/resources/CADD/CADD%20Documents/NCDOT%20CADD%20Software%20Versions.pdf
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1.4.3 2D Element Templates

Line styles are now assigned to Element Templates, which must be selected before use. Using the correct 
Drawing Line Styles is important in OBD to capture accurate quantities.  

Note: Do not place dimensions and text in the Design Model. 

1st Use the Drawing workflow

2nd Select the Template dropdown tab

3rd Select the correct Element to be drawn, 
ei. If you’re drawing an End Bent cap, select 
“Abutments”… “Caps”

Once the correct Element Template is selected, the Line Style/Level 
is automatically set

Once the correct Element Template is selected, you 
can use the Placement tools for drawing 
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1.4.4 Level Name Convention

SMU level names reflect the Department’s level naming policy.

Naming convention:   Element State_Unit Name_Element Type

Element State = Existing elements E

Proposed elements P 

Unit Name = Structures Management Unit SMU

Element Type = Element Name 
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1.4.5 Feature Definitions

SMU OBD workspace has feature definitions defined for many of the commonly used proposed bridge elements. 

1.4.6 SMU Tools

The SMU OBD workspace has a “SMU” tab under the Drawing workflow, where the in-house SMU NCBDS 
tools are located.  

The SMU Program tools are for SMU Staff use with NCBDS design software.  These tools can be used in the 
Sheet Model and used like the SMU Standard Plans. 
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1.4.6.1 Placing Typical Section From NCBDS

To place Typical Section Drawing, follow these steps.

 1st Use the SMU tab

2nd use the SMU Typical Section for placing Typical Section Drawings

3rd select the desired project from the table. 4th Use the “Draw Typ. Section Select Project” button to 
place the selected typical section in your dgn.
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1.4.6.2 Placing LRFR Summary Table From NCBDS

To place LRFR Table Drawing, follow these steps.

 

 

1st Use the SMU tab.

2nd use the “LRFR TABLE” for placing LRFR summary table. 

3rd select the desired project from 
the table. 

4th Use the “PLACE TABLE” button to 
place the latest LRFR table created for 
the selected project in your dgn.
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1.4.6.3 Placing Bolted Field Splice From NCBDS

  To place Bolted Field Splice Drawing, follow these steps.

1st Use the SMU tab.

2nd use the “BOLTED FIELD SPLICE” for placing bolted field splice Sketch. 

3rd select the desired project 
from the table. 

4th Use the “Draw BFS” button to place the selected 
bolted field splice in your dgn.
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1.4.7 Bridge Templates

The 3D Bridge Element Template Libraries have been developed to include many of the commonly used 
NCDOT bridge elements. To modify the element templates, copy the libraries from the workspace into the 
project Workset folder in ProjectWise and use the tools described in Chapter 6 to edit.  

Deck Templates

NCDOT Deck Templates have been established for commonly used deck types.  

Template Name Description

NC AWS w/constraints Normal crowned asphalt deck 

Asphalt Wearing Surface Asphalt wearing surface for cored slabs and box 
beams

Cored Slab Concrete wearing surface for cored slabs and box 
beams 

LT Super Deck w/constraints Left supered deck with overhangs

NC Deck w/constraints Normal crowned deck with overhangs

RT Super Deck w/constraints Right supered deck with overhangs

Timber Flat timber plank deck
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Barriers Templates

NCDOT’s standard bridge rails have templates created to match standard drawings. Note that the metal rails are 
still a work in progress with the software but the concrete parapets are what is generated.

Template Name Description Applicable Standard
1 BMR LT Parapet Left one bar metal rail STD NO. BMR 1
1 BMR RT Parapet Right one bar metal rail STD NO. BMR 1
2-BMR LT PARAPET Left two bar metal rail STD NO. BMR 3&4
2-BMR RT PARAPET Right two bar metal rail STD NO. BMR 3&4

2-BMR LT PARAPET w/SIDEWALK Left two bar metal rail w/sidewalk
STD NO. BMR 3&4 with DM 

Figure 6-16 

2-BMR RT PARAPET w/SIDEWALK Right two bar metal rail w/sidewalk
STD NO. BMR 3&4 with DM 

Figure 6-16
3-BMR LT w/ SIDEWALK Left three bar metal rail STD NO. BMR 5, 6,&7
3-BMR RT w/ SIDEWALK Right three bar metal rail STD NO. BMR 5, 6,&7
8" CURB LT Left 8" Curb STD. BAS 1-4
8" CURB RT Right 8" Curb STD. BAS 1-4
ALASKA RAIL LT PARAPET 32" Left Alaska Rail STD NO. BMR 8&9
ALASKA RAIL RT PARAPET 32" Right Alaska Rail STD NO. BMR 8&9
CBR LT 32" Left concrete barrier rail 32" STD NO. CBR 1
CBR RT 32" Right concrete barrier rail 32" STD NO. CBR 1
CBR LT 42" Left concrete barrier rail 42" STD NO. CBR 1
CBR RT 42" Right concrete barrier rail 42" STD NO. CBR 1
MEDIAN Median  DM Figure 6-19
MEDIAN BARRIER Median barrier DM Figure 6-27/28
OREGON RAIL LT PARAPET 42" Left Oregon Rail 42" STD NO. CBR 10&11
OREGON RAIL RT PARAPET 42" Right Oregon Rail 42" STD NO. CBR 10&11
SIDEWALK LT Left sidewalk DM Figure 6-16
SIDEWALK RT Right sidewalk DM Figure 6-16
TIMBER RAIL LT 42" Left Timber Rail 42" STD. TB_BRS
TIMBER RAIL RT 42" Right Timber Rail 42" STD. TB_BRS
VERTICAL RAIL LT 42" Left Vertical Rail 42" STD NO. CBR 2
VERTICAL RAIL RT 42" Right Vertical Rail 42" STD NO. CBR 2

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 1
___________________________________________________________________________________________GENERAL

1–18

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 1
___________________________________________________________________________________________GENERAL

1–19

Beam Templates

NCDOT’s standard cored slab and box beam units were created 

Template Name Description Applicable Standard
18" Cored Slab-Interior Interior 18" Cored Slab Unit STD NO. PCS 1
18" Cored Slab-LT Ext Left Exterior 18" Cored Slab Unit STD NO. PCS 1
18" Cored Slab-RT Ext Right Exterior 18" Cored Slab Unit STD NO. PCS 1
21" Cored Slab-Interior Interior 21" Cored Slab Unit STD NO. PCS 2
21" Cored Slab-LT Ext Left Exterior 21" Cored Slab Unit STD NO. PCS 2
21" Cored Slab-RT Ext Right Exterior 21" Cored Slab Unit STD NO. PCS 2
24" Cored Slab-Interior Interior 24" Cored Slab Unit STD NO. PCS 4
24" Cored Slab-LT Ext Left Exterior 24" Cored Slab Unit STD NO. PCS 4
24" Cored Slab-RT Ext Right Exterior 24" Cored Slab Unit STD NO. PCS 4
27" Box Beam-Interior Interior 27" Box Beam Unit STD NO. PCBB  2 & PCBB 3
27" Box Beam-LT Ext Left Exterior 27" Box Beam Unit STD NO. PCBB  2 & PCBB 3
27" Box Beam-RT Ext Right Exterior 27" Box Beam Unit STD NO. PCBB  2 & PCBB 3
33" Box Beam-Interior Interior 33" Box Beam Unit STD NO. PCBB  4 & PCBB 5
33" Box Beam-LT Ext Left Exterior 33" Box Beam Unit STD NO. PCBB  4 & PCBB 5
33" Box Beam-RT Ext Right Exterior 33" Box Beam Unit STD NO. PCBB  4 & PCBB 5
39" Box Beam-Interior Interior 39" Box Beam Unit STD NO. PCBB  6 & PCBB 7
39" Box Beam-LT Ext Left Exterior 39" Box Beam Unit STD NO. PCBB  6 & PCBB 7
39" Box Beam-RT Ext Right Exterior 39" Box Beam Unit STD NO. PCBB  6 & PCBB 7
AASHTO Type II Girder 36" AASHTO Girder - Standard Section   STD NO. PCG 1
AASHTO Type III Girder 45" AASHTO Girder - Standard Section STD NO. PCG 2
AASHTO Type IV Girder 54" AASHTO Girder - Standard Section STD NO. PCG 3
63" Modified Bulb Tee Girder 63” Modified Bulb Tee Girder STD NO. PCG 7
72" Modified Bulb Tee Girder 72” Modified Bulb Tee Girder STD NO. PCG 8
36” FIB Girder 36” Florida I-Beam Girder STD NO. FIB36
45” FIB Girder 45” Florida I-Beam Girder STD NO. FIB45
54” FIB Girder 54” Florida I-Beam Girder STD NO. FIB54
63” FIB Girder 63” Florida I-Beam Girder STD NO. FIB63
72” FIB Girder 72” Florida I-Beam Girder STD NO. FIB72
78” FIB Girder 78” Florida I-Beam Girder STD NO. FIB78
84” FIB Girder 84” Florida I-Beam Girder STD NO. FIB84
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1.5 ACRONYMS AND ABBREVIATIONS

2D Two dimensional

3D Three dimensional

4D Four dimensional

ALG NCDOT Roadway Alignment File

BrIM Bridge Information Modeling

CADD Computer-aided design and drafting

ECTM Existing Complex Terrain Model

LOD Level of Development

NCDOT North Carolina Department of Transporation

ORD OpenRoads Designer

OBD OpenBridge Designer

OBM OpenBridge Modeler

PGD Preliminary General Drawing

PW ProjectWise

SMU Structures Management Unit
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CHAPTER 2

PROJECT MANGEMENT

2.1 PROJECT MANAGEMENT CONSIDERATIONS

2.1.1 Project Scoping (PDN 2ST1)

As NCDOT and SMU continue to advance use of the OpenX software, it is important the 
project team is aware of what the project expectations are for the project task during the 
project scoping meeting. 

2.1.2 Project Workflow

Each project scoping meeting should include project team members for all disciplines of 
work involved with the design to determine the following:

• The stage in the design process where the structure model/PGD is required.  

• How ProjectWise will be used to share live DGN files between disciplines. 

• How culverts will be modeled and who is responsible for creating the stream alignment.  

• How the bridge slopes and slope protection will be created by either Roadway or 
Hydraulics. 

• If there are retaining walls in-front of and/or beside the structure, who (Roadway or 
Geotechnical) will create models for them based on Structures provided cap/wing wall 
elevations and offsets. 

2.1.3 Project Deliverables

The NCDOT Project Manager responsible for the entire project should make the project 
team members aware of what project deliverables are, and if a 3D Structural Model is 
required and what level of development (LOD) for the 3D model is required for each 
structure.  Project Teams should leave scoping meetings knowing what types of the 
following deliverables are required (note: all PDFs are submitted via SharePoint and all 
DGNs should be submitted in ProjectWise):

PDN 2ST2 Preliminary General Drawings Submittal

First Submittal

• 2D PGD (PDF).  

• Preliminary 3D Structural Digital Twin (DGN) (if applicable). 

• Preliminary Header Elevations (if applicable).

• Vertical Abutment Wall Envelopes (if applicable). 

Final Submittal

• 2D PGD (PDF & DGN).  
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• Preliminary 3D Structural Digital Twin (DGN) (if applicable). 

• Preliminary Header Elevations (if applicable).

• Vertical Abutment Wall Envelopes (if applicable). 

PDN 3ST1 Complete Structures Design

• Geotechnical Foundation Loads.

• Access Drawings.

• Coast Guard Permit Sketches (if applicable).

• Railroad Easement Sketches (if applicable).

• Permit Impacts. 

90% Structures Design Submittal

• Final 2D Structure Plans (PDF).

• Final 3D Structural Digital Twin (DGN) (if applicable)
• Project Special Provisions Package (PDF).

• Working Day Calculations (PDF). 

PDN 4ST1 Finalize Structure Design PS&E

100% Structure Design 

First Submittal

• 2D Structure Plan Sheets Combined (PDF).

• 3D Structural Digital Twin (DNG) (if applicable).

• Structures Project Special Provisions Package (PDF).

• Structure Pay Items & Quantities (PIQ).

Final Submittal

• PE Sealed and E-Signatures, 2D Individual Structure Plan Sheets (PDF).

• 2D Structure Plan Files without PE Seals (DGN).

• Final 3D Structural Digital Twin (DNG) (if applicable).

• PE Sealed and E-Signatures Structure Design Calculations (PDF). 

• PE Sealed and E-Signatures Structures Project Special Provisions Package (PDF).

• Bridge Construction Elevations (PDF).

PDN 5ST1 Structure Construction Support
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• Perform construction revisions to address identified 3D model (if applicable)/2D plan errors 
or field changes initiated by NCDOT or the Contractor. 

2.2 FILE STORAGE

As per the Chief Engineer’s Memo, moving forward all project files, other than confidential 
documents, should be stored within NCDOT’s ProjectWise Explorer. All structures related 
DGNs and sealed design calculations shall be housed in the “Structures” folder under its 
respective project folder.  Files should be created using the SMU naming convention and 
include the appropriate metadata to make the file searchable in the future. 

2.2.1 ProjectWise Explorer Guidance

ProjectWise guidance documents for creating, saving, searching and exporting documents 
can be found here https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx.

All ProjectWise project folders will be set up by the NCDOT Project Manager through 
SharePoint. Adding structures on the project in SharePoint will generate a folder for each 
structure under the “Structures” main folder overnight. If a project does not have the correct 
structure folders in ProjectWise, contact the NCDOT Project Manager.   

2.2.2 Structures ProjectWise Folder Structure

The folder structure for the “Structures” project work has been predetermined and set to 
allow the Department of Information Technology (DIT) to manage and maintain it from an 
administrative level. When the project folder is created the template will create a 
“Structures” folder which will have the structures folders listed (such as “BRG” and “CUL” 
folders) with three subfolders; “Design,” “PDF,” and “Plans.”   

The structure folders, such as “BRG” and “CUL,” may not be copied to create additional 
structure folders for a project, this must be done using SharePoint. If edits need to be made 
to a project folder, such as adding or removing structures from a project, this should be 
done in SharePoint and the corresponding updates will be made overnight within 

https://connect.ncdot.gov/resources/CADD/ProjectWiseDocuments/2023.10.25_ProjectWise%20Memo_NCDOT%20Chief%20Engineer.pdf
https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx
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ProjectWise. Project Engineers should make sure that the correct structure type ID’s are 
being used within SharePoint and ProjectWise to ensure correct workflow when the project 
is moved from PreConstruction to Construction within SharePoint. Also, the “Design” 
“PDF” and “Plans” subfolders should not have their names edited, nor should other 
subfolders be added. 

2.2.3 Structures Folder Naming Convention

When the project is created in SharePoint, the ProjectWise structure folders will be 
automatically generated the following day. If the folder naming convention does not match 
the following, contact dot.pwsupport@ncdot.gov 

Naming convention:        Structure Type ID_##_SMU 6-digit NBI ID

Structure Type ID = Bridge                                BRG
Culvert                               CUL
High Mast Lighting           HML
Noise Wall                         NW
Other                                  OT
Overhead Sign                   OS
Penstock                             PS
Retaining Wall                   RW
Temporary Structure          TMP

## = the structure numbering used on the plans for multiple structures on a project (i.e. 
STR#01, STR#02, etc.). Construction uses these to identify the structures in the field and 
our folders will now roll over to the Construction side of SharePoint.   

SMU 6-digit NBI ID = the structure ID SI&A gives a structure that is inspected and 
reported to FHWA for NBIS compliance 

mailto:dot.pwsupport@ncdot.gov
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2.2.4 Storing Files within the Structure Folder

Files should be stored within the Structure project folder structure as follows: 

Structures Folder

• Overall Project Correspondence 

• Correspondence Documents involving all/more than one structure on the project

Structure Type Folder (BRG/CUL_00_000000)

• Structure Related Correspondence 

• Misc. Structure Related Documents that don’t fit under the “Design,” “PDF,” or “Plans” 
folders. 

• Reference Materials (ie. Clipped AASHTO sections for special designs, BSR, Foundation 
Recs)

Design Folder

SMU 

• Design program Input & Output files (NCBDS, RCPier, Descus, etc.)

• Excel design files (includes Quantity Estimates, Working Days) 

• Design DGN files 

• Checked PDF design output files

• Scanned design documents of handwritten materials

• Draft Project Special Provisions (PSPs) documents 

• Design Criteria/Notes (a document with notes as to why a design decision was made) 

PEF & SMU

• PE Sealed and E-Signature Final Design Calculations (PDF)
PDF Folder

• Final Electronically Sealed PDF Plan Sheets

• Final Electronically Sealed PDF PSPs

• Final PDF’d Construction Elevations

• Final Quantity Estimates 

• PDF’d Plan Sheets for Review (25%, etc.)

• Reviewed PDF Plan Sheets with comments

Plans Folder

• All final structure DGN files

• Documents related to plan production (ie. Quantity calculations, Excel files or scanned 
documents) 

-

-

-

-

-
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2.3 FILE NAMING CONVENTIONS

Each plan sheet shall be its own DGN and PDF file and follow this naming convention:

  Models shall be named 4XX_000_TIP#_SMU_BR#_MODEL_6digitStrID

  

4XX_###_TIP#_SMU_FileDescript_Sheet#_6digitStrID

TIP Number with no hyphenations (“-”) ie. B5121

All Structure files are 
in the 400 series of 
files:

• Master Project 
Structure’s Title 
Sheets and 
Index Sheets 
are 400, note 
leave off the 6-
digit structure 
ID off these files

• Bridges: STR#1 
thru STR#9 on 
the project start 
401 thru 409 

• Culverts: CU#1 
thru CU#9 on 
the project start 
at 410 thru 419, 
unless there are 
more than 9 
structures on 
the 
project…then 
use the next 
available 
number

• Walls: W#1 thru 
W#9 on the 
project start at 
420-429 unless 
there are more 
bridges or 
culverts   

Abbreviation of the drawing type using the file 
descriptions

Electronic page 
number for the 
particular bridge 
(each bridge set 
starts at 001 
and successive 
numbers are all 
odd, ie. 001, 
003, 005…) to 
allow for any 
future 
addendums 

Plan sheet number, ie. Sheet 1 of structure 1 would be S1-01
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6-digit structure ID’s XX####
XX =County Number + #### Structure Number
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CHAPTER 3

INTRODUCTION TO OPENBRIDGE DESIGNER

3.1 OPENING OPENBRIDGE DESIGNER

To use OpenBridge Designer (OBD), locate and click on the icon shown below to open the 
software. 

Once opened, the following splash screen will appear:

From here the user can browse to a DGN file, create a new DGN file, or connect OBD to 
ProjectWise (PW) to browse to an existing DGN file in PW or create a new DGN file in 
PW.   
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3.2 OBD FILE CREATION IN PROJECTWISE

Prior to creating a dgn file, a project folder must be created in ProjectWise for storage. If 
there is no project folder or structures bridge specific subfolder(s) in PW (see Section 
2.2.2), contact your NCDOT Project Manager. 

3.2.1 Connecting OBD to ProjectWise

On the OBD splash screen 

For how to create files and use ProjectWise, look at CADD Services’ website

https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx

To continue creating a file outside of ProjectWise click on the “Cancel” button and move to 
the next section. 

Make sure the Datasource is 
set to “NCDOT Production” 

and Authentication is 
“Bentley IMS”, then click on 

“Log in”

A prompt for ProjectWise will open at this step

To create a new file in 
ProjectWise, click on 

“ProjectWise”

https://connect.ncdot.gov/resources/CADD/Pages/ProjectWise.aspx
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3.2.2 Creating a New OBDX File 

 

Once OBD is logged into ProjectWise you will see the following window. 

To create a New OBDX click on the “New File” icon

Click on “Select” 
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Navigate to the structure folder and 
select the “Plans” folder, and click “OK” 

Name this file the project TIP number, ie. B-5121

Descriptions help provide more metadata for 
future searches.

Select “OBD 2023” from the drop down.
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Note: Each structure on the project will have a OBDX file for both the design and the plans that will 
need to be created.

3.2.3 DGN Creation In ProjectWise

3.2.3.1 BIM Project Workflow (2D Plans)

This workflow is not recommended, but is an option for strictly doing 2D drawings using 
old v8 SMU files, as well as Survey and Roadway files. 

Once all fields are entered, click “Save” to create the OBDX

BIM workflow is used for drawings only, use this for 
creating 2D plans 

Once a BIM workflow is selected, click the “New Folder”  
Icon

Name the subfolder for DGN’s the structure number:
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3.2.3.2 Creating a DGN in BIM Workflow

Continue creating a DGN with Sections 4.2.7-4.2.9

3rd To create a new dgn file click 
here

2nd Name your model 
ie “GD01”

1st Right click on the model, and click on 
“Rename”
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3.2.3.3 Standalone Project Workflow (2D Drawings & 3D Model)

This workflow is recommended for all projects that will use ORD reference files, and/or the 
LEAP design software.  

Standalone workflow is used for creating digital twin models capable 
of exchanging model data with design software, 3D model creation 

and using Leap Design Products.  
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3.2.3.4 Creating a DGN in Standalone Workflow

The following window will pop-up:

1st Right click on “Create Standalone File 
Group”

2nd Name your model group
ie “Structure ID”

3rd To create a new dgn file click 
here

3rd  Link to the “NCDOT 
Production” Database and use the 
“Bentley IMS” Authentication to 

Log in
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Continue creating a DGN with Sections 4.2.8-4.2.10.

3.2.4 DGN Creation in ProjectWise

NCDOT Staff will see:

Consultants will see:

Select “DOT-US North Carolina” 
Workspace and “SMU Workset”

Then, Click “New File” 

Then, Click “New File” 
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The following window will pop-up:

Select “Advanced Wizard”

Navigate to the project folder and 
down to the correct structure 

folder, before advancing

Note: The Advanced Wizard has replaced the NCDOT Design File Generator
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Use the ProjectWise document 
template.

The SMU seed file is located here with ProjectWise:
NCDOTProduction/Documents/Administration/WorkspaceGroups/NCDOTWorkspaces/Configurat
ion_2023/Workspaces/DOT-US North Carolina/Roles/NCDOT_Structures/Standards/Seed 

Note: The user only needs to select this one time, after that the seed file path will show up in the 
bottom “Select from recent used templates” box. To use it, just select the button next to “Select 
from recent used templates” and highlight the seed file. 
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Navigate to the 
“NCDOT_Structures” Workspace 
folder and select the SMU OBD-

seed3d file

For now, leave as “All 
Applications”
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Fill out the metadata 
fields for the file being 

created 

Complete the file name following 
the guidelines in Chapter 2,  note 
the metadata entered earlier will 

partially create file name. 

Select “OBM 2023” as the 
application. 

Update the Description to 
match dgn 
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Fill out the metadata 
fields that are blank that 
you can, otherwise leave 

input fields blank  

Select the metadata for the 
remaining fields, if one or more 

does not apply leave blank 
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Verify metadata fields are 
correct, otherwise use 
the “Back” button to 

revise as needed  

Use the “Finish” button to 
create the DGN  
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3.3 OPENING AN EXISTING DGN IN BIM WORKFLOW

3.3.1 Open OBD file Browser

3.3.2 Select the Project .obdx file

Once OBD is opened you will see the following window: 

To open an existing Project click on the “Browse” icon

Point the browser to the project file location

Open the project .obdx file
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3.3.3 Select and Open Existing DGN 

3.4 CREATING A NEW DGN IN AN EXISTING PROJECT IN BIM WORKFLOW

Follow the Steps found in 4.4.1 and 4.4.2 to get here.

Browse the structures and their associated DGN files here

To open an existing DGN file, select it 

Then click here to open 
the selected file

This preview screen 
allows you to zoom in 
and out of the dgn 
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To attach the dgn created to the new bridge model, see 4.3.

To create a new dgn file, click on the “+” to add another model 

Then click here and follow the 
steps found in 4.2.8-4.2.9 
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3.5 OPENING LEAP DESIGN SOFTWARE

Follow the steps outlined in 4.2.8-4.2.9, then 

Be sure to name and save Leap Design files to their appropriate project folders.   

1
st

 Select a “Standalone” workflow

2
nd

 Click “Add Standalone Group”

4
th

 Select the “Analysis” tab

5
th

 Select the LEAP Design 
application needed

3
rd

 Use the structure number 
as the Standalone Name and 

click “OK”

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 3
__________________________________________________________________INTRO TO OBD 

3–20

3.6 OBD DGN WORKFLOW

Once in OBD, selecting the correct workflow for the file is important.   

“OpenBridge Modeler” workflow is used for 
using templates in 3D digital-twin creation

“Drawing” workflow is used for both drawing 
in both 2D and 3D, and is the main workflow 

for 2D 

“ProConcrete” workflow is used for detailing 
reinforcing steel in 3D concrete members

“Task Navigation” workflow is used for 
drawing functions in both 2D and 3D

“NCDOT” workflow is used for connecting to 
NCDOT OneMAP tools

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 3
__________________________________________________________________INTRO TO OBD 

3–21

3.7 DGN MODELS

SMU utilizes the Design, Drawing and Sheet models. 

To create these models SMU uses the Drawing tools, such as Place Named Boundary. 
Future chapters will describe how to use the Drawing tools in the plan production process. 

 The following sections will describe what is in each model, how to manually rename and 
generate the models if needed, and how to view all the models using the models dialog.  

3.7.1 Models Dialog

To view models in the DGN, open the “Models” dialog box. 

The default Models Dialog Box will look like this:

There are three different types of models that can be created within a DGN; a Design 
Model, a Drawing Model, and a Sheet Model. 

Models Dialog Icon
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3.7.1.1 Design Models  

Design Models have default black backgrounds and can be either 2D or 3D .  
The default design model in SMU’s seed file is 3D and will remain as a 3D model, the user 
can close the view 2 window and save settings to remove the isometric view and make the 
model feel like a 2D model. A Design Model is meant to contain the following information:

• 3D digital twin that represents what is to be built or an existing structure, drawn 
full size (1:1) or,

• 2D elements that represent what is to be built or is existing, drawn full scale (1:1)
• Not intended for publication, only for editing 
• Can be a part of a complex design, where multiple design models can be 

referenced to each other to form a design composition.

To rename the default Design Model:
Select the Default Design Model 

Click on the “Properties” icon 
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Once the Properties are updated as needed, save the file and close the Properties dialog box. 

To create a new Design Model

Click on “Create New Model” 

Change Model Name 

Change Description 
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3.7.1.2 Drawing Models

Drawing Models have a default grey background and are always 2D . A Drawing 
Model is meant to contain the following information:

• An area for attaching Design Models 1:1 as references (typically done with the 
drawing tools cutting views of the 3D digital twin)

• Used as the location where non-sheet specific annotation is applied (dimensions, 
callouts, etc.) 

To create a new Drawing Model, without using a drawing tool (such as the Place Named 
Boundary tool).

Select 2D or 3D 

Provide a Name and 
Description 

Design Models should be 
“Full Size 1=1”

Set the Model Type to “Design” 
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3.7.1.3 Sheet Models

Sheet Models have a default white background and are always 2D . A Sheet Model is 
meant to contain the following information:

• Used to define the ready for printing document
• An area where the Drawing Models are referenced and attached at their own 

scale to create a final plan sheet 
• Has defined printing output settings (like ANSI D paper size)
• Includes a sheet boundary which defines the printing area  

Click on “Create New Model” 

2D is automatically set

Provide a Name and 
Description 

Drawing Models scales will 
need to be changed from 
“Full Size 1=1” once the 
“Design Model” is 
referenced, because 
annotation is placed here

Set the Model Type to “Drawing” 

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 3
__________________________________________________________________INTRO TO OBD 

3–26

To create a new Sheet Model, without using a drawing tool

Click on “Create New Model” 

Set the Model Type to “Sheet” 

2D is automatically set

Provide a Name and 
Description 

Sheets are always “Full Size 1 = 1”

Set size to “ANSI D”
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3.8 CIVIL TOOLS

The Civil tools are an application designed to provide Civil/Site functions 

3.8.1 Civil Analysis Point Tool

To find stations, elevations, and offsets of locations along the -L- or other alignments, use 
the following tools:

3.8.1.1 Finding Stations, Elevations and Offsets along an Alignment

To find the station, elevation and offsets of a location along an alignment, after selecting 
the Analyze Point tool, Click on the alignment to which you want to find the station, 
elevation and/or offset from, then click on the point which you want the info for and the 
information will be displayed in a box beside the curser. 

Select the “Analyze Point” tool
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3.8.1.2 Finding Elevations along the Terrain

To find an elevation on the terrain, select the Analyze Point tool. Select a leg of the terrain 
triangle nearest to your point of interest and then click on the point of interest to get the 
exact elevation at that point. 

The elevation will appear in a display window beside the curser as you move along the leg of the 
traingle, but will also be displayed in the Analyse Point toolbox window when the point is selected. 
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3.8.2 Horizontal Geometry Tools

3.8.2.1 Point

To place a point on an alignment similar to what was done in the past using GEOPAK, use 
the Horizontal Geometry Point tool. 

To place a point (or work point) along an alignment, first turn on Civil Accudraw.

Expand the tool:

Select the “Station-Offset”

Then select the Point tool
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To place a workpoint, select the Workpoint feature definition: 

Set the workpoint name:

Select the alignment: 
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Then press the letter “O” on your keyboard

The Workpoint symbol will appear, as well as the Station and offset input box. 

Enter the Station for the placement of the workpoint and use the tab button to move to the 
Offset and Z cells. 

3.8.2.2 Offsetting Roadway Alignments

To offset a Roadway alignment to establish horizontal clearances and offsets requires using 
the Offsets and Tapers tools. Copying Roadway alignments without using these tools can 
cause an OpenBridge file to become “read only” due to the civil data linked with the 
alignment. 

Use the “Offsets and Tapers, Single Offset Entire Element” tool. 

Once a tool is selected, provide the desired offset and any other necessary information.
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Select the alignment to offset and click again to set the offset line. 

3.8.2.3 Creating an Horizontal Alignment 

In the default model, attach the ECTM and FS files in Coincident-World orientation.

After the reference files are attached, fit the views to the structure location. 
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Hover over the existing alignment created by L&S in the View 1 (plan view) to determine if 
there is an active profile line. In the image below, there is no active profile established for 
the existing alignment. 

To create an alignment, go to the “Civil” tab, and in the “Horizontal” tools use the “Offsets 
and Tapers” tool, “Single Offset Entire Element”

 

Before you click on the surveyed centerline of structure, set the offset to 0:0 (no offset from 
the alignment element L&S created from surveying the center of existing roadway.) 

Set the Feature Definition to “Existing ALG Centerline” and Name the Line to match 
L&S’s name, then select the line in the plan View 1 window
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In View 1 (plan view), click on the L&S alignment to select it, and to set it. 
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To set the stations, use the Horizontal “Modify Start Station” tool. 

Enter the starting station desired (typically 10+00.00) into the Parameters box. 

Then select the alignment in the plan view and follow the prompts, click to accept. 

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 3
__________________________________________________________________INTRO TO OBD 

3–36

3.8.3 Vertical Geometry Tools

3.8.3.1 Adding Vertical Geometry to an Alignment 

After a horizontal alignment is created, hover over the centerline survey over the structure, 
right click and hold, go to “View Control”, “3 Views Plan/Profile/3D
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Select “OK”

In View 1, click on the created alignment and then move your curser to View 4 and click. 

The profile along the alignment should appear in the View 4 window.  

If it does not appear, zoom out in View 1 and activate the terrain file by finding the survey 
boundary line (the outline of the survey) and hovering over it until the property’s icon 
toolbox pops up. Select the second icon “Set Active Terrain Model”. 

Go back to View 4 and click the “Fit View” icon and the profile should appear. 
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To add a vertical alignment, use the “Complex Geometry by PI” tool

Set the Feature Definition and Name to match what was used in the Horizontal Offset and 
Tapers tool. 

Then, use the tool in View 4 to click on points along the profile and create a vertical 
alignment. 

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 3
__________________________________________________________________INTRO TO OBD 

3–39

Now, set the newly created alignment as “Active” by selecting it and move off and back on 
the line until the tool bar pops up. Once the tool bar appears, select the second icon “Set As 
Active Profile”. 
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3.9 PLACE NAMED BOUNDARY TOOL

The Place Named Boundary tool can be used in both 2D and 3D plan production for 
creating views used in plans.  

Place Named Boundary tool options from left to right:

• Civil Plan: 3D modeling tool allows the user to select a horizontal alignment with 
which to associate the named boundary for a plan view by defining the boundary 
scale, length, left and right offsets. 

• Civil Plan by Element: 3D modeling tool allows the user to select a horizontal 
alignment with which to associate the named boundary, along with an existing 
element as a boundary for a plan view. 

• Civil Profile: 3D modeling tool allows the user to select an alignement’s vertical 
profile with which to associate the named boundary by selecting the boundary limits 
from an existing civil plan boundary or by station definitions. 

• Civil Cross Section: 3D modeling tool allows the user to select the horizontal 
alignment with which to associate the named boundary by defining left and right 
offets and the intervals at which to create the cross sections. (not preferred for 
creating bridge typical sections)

• Civil Cross Section by 2 Points: 3D modeling tool allows the user to select the 
horizontal alignment with which to associate the named boundary by clicking a 
point either side of the selected alignment to form a line crossing the alignment 
which creates a cross section at that location.

• From Drawing Boundary: 2D drawing tool allows the user to select one of the 
predefined drawing scales and fit the boundary view box around an area to create a 
plan view.

• By Element: 2D drawing tool allows the user to select an existing element as a 
boundary.

• By 2 Points: 2D drawing tool allows the user to select two points that define a 
rectangular boundary. This is the most preferred method for 2D workflow. 

• By Polygon: 2D drawing tool allows the user to click several points to create a non-
uniform multi-sided closed shape (must contain at least 3 sides) as a boundary.

• By Length: 2D drawing tool allows the user to select a path element along which to 
place a boundary by then defining the left and right offsets and boundary length.
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3.10 SPACEBAR

A quick way to get to commonly used tools is to click on the spacebar, the following popup 
will appear near where your curser is at for your selection. 

3.11 BACKGROUND MAP

To place a street or aerial map in your drawing background, take the following steps:

1st In the window View, click on “Select Background Map” 

2nd Drop down to “Map Type” and select the map style desired.  
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3.12 CUSTOM LINE STYLES 

To use the NCDOT custom line styles for both 2D and 3D, follow these steps:  

 

Select the “Drawing” workflow

Select the “Line Styles” drop down

Find the custom line style 
desired.
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3.13 SKEWS

Refer to Section 4.1.2.2 of the Structures Management Unit Design Manual for information 
on how to show the skew angle on plans.

The following detail shows how Bentley calculates skew angles for OpenBridge Designer 
tools and LEAP Concrete software, note the difference. 
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3.14 DRAWING SCALES 

SMU drawing scales and ratios

Drawing Scales
English Scales Engineering Scales

Full Size 1=1 1:1 1” = 5’ 60:1
6” = 1’-0” 2:1 1” = 10’ 120:1
3” = 1’-0” 4:1 1” = 15’ 180:1
2” = 1’-0” 6:1 1” = 20’ 240:1

1 ½” = 1’-0” 8:1 1” = 30’ 360:1
1” = 1’-0” 12:1 1’ = 40’ 480:1

7/8” = 1’-0” 13.7:1 1” = 50’ 600:1
¾” = 1’-0” 16:1 1” = 60’ 720:1

5/8” = 1’-0” 19.2:1 1” = 100’ 1200:1
½” = 1’-0” 24:1 1” = 200’ 2400:1

7/16” = 1’-0” 27.4:1 1” = 300’ 3600:1
3/8” = 1’-0” 32:1 1” = 400’ 4800:1

5/16” = 1’-0” 38.4:1 1” = 500’ 6000:1
¼” = 1’-0” 48:1 1” = 600’ 7200:1

3/16” = 1’-0” 64:1 1” = 1000’ 12000:1
1/8” = 1’-0” 96:1 - -

1/16” = 1’-0” 192:1 - -
1/32” = 1’-0” 384:1 - -
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CHAPTER 4

DRAFTING AND PRINTING

4.1 DRAFTING/MODEL REQUIREMENTS

All elements shall be drafted/modeled full scale (1:1) in their geospatially correct location 
using survey and/or alignment files for both 2D and 3D DGNs to ensure plans accurately 
depict the intended design. Drafting and modeling full scale will avoid design errors and 
capture potential construction conflicts and clashes with items such as utilities, drainage, or 
interim phases in staged construction. 

4.1.1 2D Drawings

Each plan sheet in a plan set shall be its own DGN file. 2D drawing DGNs shall include 
Design, Drawing and Sheet Models. See Chapter 3 for more details on DGN models. Use of 
the correct element templates is critically important to ensure elements can be easily 
identified within the DGN. 

All final plan sheets shall be in the Sheet Model. 

Draft full-scale (1:1) details in the design model and scale views on sheet model as needed 
to provide clarity when displayed or printed on a plan sheet.    

4.1.2 3D Models

Create 3D models in the Design Model (see Chapter 3 for more details on DGN models). 
Each structure model shall be its own DGN file. 

In lieu of drafting 3D elements from scratch, whenever possible use and modify the 3D 
element templates available in the element? libraries. Copy and save the element templates 
to the project’s Bridge Templates folder prior to modifying.   

In order to share information in the 3D model with Construction and Asset Management, 
Item Types shall be attached to each element on the structure. 

2D drawings may be created from the 3D model by referencing the 3D model into the 
appropriately named Design Model DGN file. Use the Drawing Creation tools (e.g. Place 
Name Boundary, and Typical Section) to generate views (section, plan, elevation, etc.) of 
the selected element in both the drawing and sheet models and to create the final plan sheet. 

4.2 DETAILING REQUIREMENTS

Before starting to draft plans, determine which details are necessary to efficiently construct 
the bridge and manage the asset during its lifecycle.  Present these details in a logically 
grouped order in the contract plans. Avoid scattering details throughout the plans and 
overcrowding a sheet with details and notes. Use standard line styles, line weights, 
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lettering, reference notes, etc., to produce plans that are consistent from project to project.  
Arrange drawings and details by determining what information needs to be placed on each 
plan sheet, the scales of the details shown, the number of sheets and sequence of sheets 
based on information found in Chapters 1, 4 and 5 of the Structures Management Unit 
Design Manual.  

4.2.1 Drafting Scales

Refer to Chapters 1, 4 and 5 of the Structures Management Unit Design Manual for 
information on drafting scales.   

4.2.2 Line Styles and Line Weights

Element Templates will set the line level, style, weights and feature definitions. Select and 
use the appropriate Element Template for the structure element being drafted.  

When the correct Element Templates are used, the SMU pen table will plot the “Existing” 
element line styles at a reduced intensity and “Proposed” element line styles in bolded 
intensity to contrast and display importance. 

4.2.3 Dimensions 

For precision of dimensions, see Figure 1-2 of the Structures Management Unit Design 
Manual.  

Used the following guidance to show dimensions on plans: 

• Show dimensions that are less than 1-inch in fractions of an inch, without a leading 
zero (e.g. ½” ) 

• Show dimensions that are an inch or greater, but  less than 12-inches, in whole inches 
and fractions of an inch (e.g. 4½” ) . 

• For dimensions that are 12-inches or greater, show dimension units in feet, inches and 
fractions of an inch (e.g. 1’-3½” ).      

• Place horizontal dimension lines so they can be read from the bottom of the plan 
sheet with dimensions above the dimension line. 

• Place vertical dimension lines so they can be read from the right side of the plan sheet 
with dimensions on the left side of the dimension line. 

• Place inclined dimension lines so they can be read horizontally by rotating the plan 
sheet through the smallest angle possible. 

4.2.3.1 Placing Dimensions and Notations

The NCDOT Workspace utilizes generalized dimension styles for all Technical Service 
Units. 
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For efficiency and standardization, SMU has created Element Templates that automatically 
select the correct generalized NCDOT text styles for plan production. 

To place dimensions, go to the Element Templates > SMU > Annotation > Dimension 
Lines

Then go to Annotate > Place Text tool, this will automatically set the text style set in the 
template. SMU utilizes the NCDOT “Fractions” dimensions style in the workspace. 

To place notations, go to the Element Templates > SMU > Annotation > Notes.
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Then go to Annotate > Place Text tool, this will automatically set the text style set in the 
template. SMU utilizes the NCDOT “Fractions” dimensions style in the workspace. 
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4.2.4 Text Properties

All text placed on plan sheets shall be capitalized. 

The NCDOT Workspace utilizes generalized text styles for all Technical Service Units. The 
naming convention uses the following format: 

(Text Size)_(Font Name)_(Justification)-(Additional setting)

For efficiency and standardization, SMU has created Element Templates that automatically 
select the correct generalized NCDOT text styles for plan production. 

Go to the Element Templates > SMU > Annotation > Detail Text (or the desired text 
style: Notes, Subtitle, Title) 

Then go to Annotate > Place Text tool, this will automatically set the text style set in the 
template. Do not change any settings, place text as normal. 

The following text styles are set for SMU plan production:

Dimension Text Style = 0120_Engr Vert_CC 

Notes Text Style = 0120_Engr Vert_LB

Subtitle Text Style = 0160_Engr Vert Mono_CC

Title Text Style = 0210_Engr Vert Mono Bold CC  
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4.2.4.1 Title Block

The SMU title block is located in the lower right hand corner of SMU borders. The title 
block provides users a brief description of information presented on the plan sheet, the 
project number, the county where the project is located, the station where the structure is 
located along the alignment, sheet number, number of sheets in the plan set, etc. For 
additional information on what is required in the title block for the various plan sheets, see 
the Structures Management Unit Design Manual.  

Use the following guidance for title blocks on plan sheets:

• Use SMU’s Title Text style for the Project Number (e.g. B-1000), County (e.g. 
WAKE), Station/Bridge Number (e.g. 10+00.00 -L-) sections of the title block, as 
well as the sheet title (e.g. GENERAL DRAWING). 

• All Sheet titles shall be spelled out completely. (e.g. GENERAL DRAWING, 
TYIPCAL SECTION, etc.) 

• Use SMU’s Subtitle Text style for supporting sheet title information (e.g. BRIDGE 
ON SR 1000…). 

• Abbreviations for supporting sheet title descriptions are acceptable when space is 
limited (e.g., W. 5TH ST. for WEST FIFTH STREET) 

• Use SMU’s Detail Text style for additional title block information (e.g. SHEET 1 of 
4, REPLACES BRIDGE No.) as well as the sheet number and total number of 
sheets.    

4.2.4.2 Professional Engineer Seals

Professional Engineer (PE) Seals shall be created and placed with the SMU PE Seal 
element template. 

Go to the Element Templates > SMU > Annotation > PE Seal

SMU Title Text 

SMU Subtitle Text 

SMU Detail Text 

SMU Title Text 

SMU Detail Text 
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Then go to Annotate > Place Text tool, this will automatically set the text style set in the 
template. Do not change any settings, place text as normal. 

To create a customized PE, in a newly created DGN copy the Create Seal model in the 
SMU_PE_Seals cell library and follow the instructions in the model. For future reuse, save 
the newly created PE seal DGN in a location that can be easily referenced.  

4.2.4.3 Names on Plan Sheets

For Drawn By, Checked By and Design Engineer of Record, use SMU’s Detail Text style. 

When drawings are revised or updated by someone other than the original drafter, keep the 
original drafters name and use a forward slash and place the second drafters initials (e.g. 
DRAWN BY: J.A. DOE/B.C.H.). This also applies to checkers. 

Do not use initials for the Design Engineer of Record. 

4.2.4.4 Federal Aid Numbers

For labeling the federal aid number in the top right hand corner of the first general drawing 
sheet, use SMU Subtitle Text style. 

4.2.4.5  Notes and Legends 

Use SMU’s Title Text style for labeling notes and legend titles. 

For notes and legends, use SMU’s Notes Text style. 

Legends shall provide symbols used to describe the items on a sheet. 

4.2.4.6 Details, Sections and Views

Labels for details, sections and views shall be SMU Title Text style. 

When showing multiple views to detail the same element, use SMU Subtitle Text style to 
label the different views. 
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Avoid using abbreviations for labeling details and views. 

Use lettered section labels for each bridge component (e.g. SECTION A-A). Continue 
lettering section labels A to Z through all plan sheets related to a component.  Details and 
section views do not need to be on the same sheet(s) as where they are called out, if they are 
not on the same sheet indicate on the call out what sheet to see. 

Letters used for sections may repeat for each new bridge component. Avoid the use of 
double lettered sections (e.g. SECTION AA-AA). 

4.2.5 Detailing Reinforcing Steel

For reinforcing steel detailing requirements, see Section 10.4 the Structures Management 
Unit Design Manual.   

For bar callouts, use SMU Notes Text style and the NCDOT_Leader Arrow_Fractions 
dimension styles. 

Reinforcing steel shall be labeled by using the following name convention:

Number of bars-#Bar Size Bar Location ID_Bar Label, Sequence

Identify reinforcing steel first by the number of bars, the bar size, the bar location I.D., the 
bar label, and the spacing. (e.g. 4-#4 D_B3 @ 6” CTS.) If only one bar is being identified, 
start the with the bar size. (e.g. #4 A_B1 BAR) See bar location I.D.’s and bar label tables 
below. 

Use abbreviations and symbols to reduce clutter. The following are commonly used: 

Abbreviation/Symbol Description
@ At

B.B. Beam Bolster
B.B.U. Beam Bolster Upper

C.H.C.U. Continuous High Chair Upper
CL. Clear

CTS. Centers
DBL Double

Ø Diameter
DIAPH. Diaphragm

EA. Each
EQ. Equal

RAD. Radius
REQ’D Required
SPA. Spaces

THRU Through
TYP. Typical
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4.2.5.1 Bar labels

Bar labels start with the bar location I.D. which corresponds to the element where the bar is 
located. 

Bar Location I.D. Bridge Component

A Abutment/End Bent and foundations

B Bent and foundations

C Culvert

D Deck

G Girders & Diaphragms

M Median islands and sidewalks

R Barrier Rails

S Approach Slabs

W Wing Walls and Walls 

Start label sequences at one through ninety-nine.(e.g. A1, A99) When introducing cut bars 
into a section with straight bars, such as  skewed bridge decks, start the sequence counting 
at one-hundred and one. (e.g. A101) 

Label Description

A Main top bars and bottom bars of same size

B Main bottom bars, if not same as top bars

C Culvert longitudinal bars

D Dowels

E Parapet end post vertical bars

F Parapet end post horizontal bars

G Deck edge beam bars

H Horizontal bars

J

K Diaphragm bars

L

M Drilled Pier vertical bars

N

P
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R

S Stirrups

SP Spiral Steel

T

U “U” shaped bars

V Vertical bars

W

X

Y

Z

4.2.5.2 Bill of Materials

Provide bill of material tables as described in Section 10.4.4 the Structures Management 
Unit Design Manual.   

SMU has developed Bill of Material seed templates. To place bill of material tables, go to 
Annotate > Place Tables tool. Select the appropriate SMU Bill of Material seed. 

Use SMU Detail Text style for the Bill of Material values. 

Identify bar types in Bill of Materials from the Bar Bending Details Standard. 
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For bent bars, provide a sketch per Bill of Materials with leg dimensions and bend offsets 
using the bar types from the Bar Bending Details Standard.   

4.2.6 Cell Libraries and Steel Shapes

Cell Libraries

Cell libraries match the Element Templates. 

To place cells, go to Annotate > Place Active Cells tool. 

To select the cell library, click on the dots next to Active Cell. 

Under File, select the appropriate cell library in the list. 
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Once a cell library is selected, the list of cells within that library will be displayed. 
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To place a cell, double click on the cell in the list and place it in the model. 

Steel Shapes

Bentley’s steel shape application has been placed in the workspace and will open 
automatically with the workspace. 

To use the tool, first click on the right folder icon and set the Steel Section Parameters. 

Set Color and Weight to “By Level” and select the appropriate level for the section being 
placed. 
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Then click on the left icon to Place the Section, use the usLRFDv3 Section table.

Select the appropriate Type (e.g.: W-Shape, etc.) and section Name (e.g.: W6x15) and 
Hatching style (e.g.: None, Hatch, Fill)

The section will appear and be ready to be placed in the model. 
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4.2.7 Plan Revisions

Plan revisions made after letting require the following:

After the necessary revisions have been made, the person making the revision shall put their 
initials and the date in the title block. Use SMU’s Notes Text style. 

A brief description of the revision should be placed next to the title block.  The initials of 
the person making the revision, the date of the revision, the initials of the person checking 
the revision and the date checked should be included at the end of the description.

A triangle, ▲, with the revision number in it should be placed next to the description and 
the corresponding revision.

Revise the sheet number to include a “R” for revision and the revision number (e.g. S1-
14R1) 

Revise the total number of sheet to also include a “R” to indicate the total number of sheets 
has been revised (e.g. 64R1)

4.3 DRAWING WORKFLOW

Once the DGN file is created as laid out in Chapter 3, for 2D drawing creation set OBD to 
the Drawing Workflow. 
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All DGN files will be set up with three modes with them:

Use the Drawing tools like the Place Name Boundary tools, as detailed in Chapter 3, to get 
drawings from the Design Model to the Drawing and Sheet Models.  

4.4 DEFAULT (DESIGN) MODEL 

For 2D drawings the Default (Design) Model will be used to draw proposed or existing 
structure elements in a 2D view at full scale (1:1) in their correct geographical locations. 
Reference the SMU Design Manual for all required content for the plan sheet being created.   

To set the DGN to look like it did in v8, in the Design Model close the “View 2” window 
and maximize the “View 1” window, then use the save settings tool. (Note: View 2 is 
utilized for 3D isometric views.)

Close “View 2” window

DGN File

Design Model Drawing Models Sheet Model
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Leave the Drawing Scale at the defualted scale of  1”=50’ and draw all elements at their 
true dimensions. 

4.5 DRAWING MODEL 

For 2D drawings, the Drawing Model is used to annotate the drawings done in the Design 
Model.  This can be achieved by referencing the drawing done in the Design Model or 
using the drawing tools to place a view of the drawing in the Design Model into the 
Drawing Model.  

After the Design Model has been referenced, it is time to set the Drawing Scale based on 
the reference view scale used in the Sheet Model for the drawing view. 

4.5.1 Drawing Scale

Once the Design Model has been referenced in, it’s time to select the drawing scale to 
annotate the drawing.  

Your scale is now set for this Drawing Model, save settings and do not change it unless the 
reference scale on the Sheet Model is changed.  Now you can place your text. 

1st Select the Utilities tab

2nd Change your Drawing Scale from the defaulted “Full Size 1=1” 
scale to match the scale used referencing this drawing into the 
Sheet Model

Save settings 
icon
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Once the Drawing Scale matches the Sheet Model reference view scale, it’s time to start 
placing dimensions. Follow these steps to place dimensions:

4.6 SHEET MODEL

For 2D drawings, the Sheet Model is used to place the Plan Sheet Border with it’s labels, 
plan sheet notes and bill of material tables. 

4.6.1 Individual Plan Sheet Borders

Once the Sheet Model is set up and ready for a border, follow these steps to place an 
individual sheet border in the Sheet Model: 

1st Select the Annotate tab

2nd Select the Place Active Cell icon
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3rd Select the “…”
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The border can now be placed as a cell in the sheet model. 

3rd Click on “File”

4th Select the SMU Sheet Border Cell 
Library 

Borders in the Sheet model should 
always be Full Size 1=1 

5th Double click on the correct border for the DGN

Change Nesting Depth to 99
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4.6.2 Referencing A Master Structure Border

This method allows the user to set up a master border for each structure on the project, so 
that the users only has to go into one file to fill out the project number, county, and 
station/bridge number as well as place a PE seal and Total Number of sheets for the entire 
project. To use this method, create a Master Border DGN file for each structure on a project 
following the steps found in Chapter 4, which will be later referenced in your plan sheets. 

4.6.2.1 Creating a Master Border DGN File

Create a new DGN file without adding Drawing and Sheet Models, in the Design Model  
follow these steps: 

 

1st Use the Drawing workflow

2nd Select the Annotate tab

3rd Select Place Active Cell Icon

4th Click on the dots to find the cell 
library

6th Select the 
“SMU_Annotation” 
cell library

7th Select either 
the “PS” plan 
sheet for design 
or the “PRR PS” 
cell for 
preservation  

7th Select either 
the “PS” plan 
sheet for design 
or the “PRR PS” 
cell for 
preservation  
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5th Click on “File” 

6th Select “SMU 
Sheet Border.cel”

7th Select the Design or PRR Plan Profile Sheet
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Place the border in the dgn Design Model at the axis origin point. Note the border will come in 
small, use the “Fit View” icon to zoom in. 

Note: The only items to be edited in a Master Border should be: 
Project No.
County
Station/Bridge No.
Total Sheets

PE Seal                                                           

Save settings and exit file. 

8th “Fit View” 
icon

9th Use the Place Text icon on the Annotate tab

Edit the Project No., County 
and either Bridge No. or 
Station for the Structure
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4.6.2.2 Referencing a Project Master Border

Once the Sheet Model for each project DGN file is set up and ready for a border, follow 
these steps to reference in the master sheet border into the Sheet Model: 

1st Select the Attach Tools icon

2nd Select Tools, 
Attach…

3rd Locate the Primary Border in the project folder created for the structure being 
drawn
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The Sheet Model scale should be left at “Full Size 1=1”. 

6th Once the border is placed, the following items need to be placed in each DGN file on the 
referenced Master Border: 

• Drawn By & Date
• Checked By & Date
• Engineer of Record
• Title
• Sheet Number
• Sheet _ of __

 4th Select the attached file
5th Use the Move Reference tool to move the 
border on to the set print fence

The reference should come in with the 
correct settings and not need changing. 

The border will sometimes be off of the 
set sheet, and often not be in view of the 
set sheet. Use the “Fit View” icon to find 
stray referenced borders. To move it 
using the “Move Reference” tool…

Change Nesting Depth to 99
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4.6.3 Placing Plan Notes with the SMU NOTES App

The SMU Notes tool is defaulted to look for the SMU notes on the SMU server. 
Consultants using the tool will need to create a folder on their C-drive to copy and paste the 
.nts files from the SMU website. 

To change the tool target folder, click on the “Load .nts from folder” button and navigate to 
the local .nts folder. 
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To place standard SMU plan notes on the Sheet Model, follow these steps

Select the SMU Notes text from the Annotation Element Template

 

Then open the SMU > NOTES app
1st  Use the SMU tab 

2nd Use the SMU Notes button for placing standard SMU plan notes 
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Note that you can change the number of characters per row by editing the number. 

4.7 PRINTING PDF’S

All printing should be generating full scale (ANSI D, 34x22) PDFs, which can be 
physically printed to any size paper when printing from your PDF viewing software.  

To avoid issues with font symbols not printing, go into the workspace 
(\Configuration_2024\Organization-Civil\NCDOT\Fonts) and copy the true type fonts (.ttf) 
files and paste them into C:\Windows\Fonts. 

4.7.1 References

Referenced files showing existing elements shall be grayed back to indicate they are 
existing versus proposed. 

To gray back reference files, in the Sheet Model go to Primary Tools > References, then 
select the referenced files to be grayscale.

3rd Use the drop 
down to select the 

note set 

4th Select the 
desired notes from 

the list

5th  Use the “Place” button 
to place the selected notes 

in your dgn 
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Double click on the files to open. 

Change the Logical Name to “grayscale” and click “OK”.
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4.7.2 Creating a PDF Document from a Single DGN

To PDF a single plan sheet file, from the Sheet Model follow these steps:

1st Select File

2nd Select Print

3rd Select Print to PDF
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Direct the Select Printer Driver Configuration File tool to the following path:

NCDOTProduction/Documents/Administration/WorkspaceGroups/NCDOTWorkspaces/Configurati
on_2024/Organization-Civil/OpenBridge Modeler/plot

4th Select the “…”

5th Select the SMU_pdf.plgcfg

6th Select “Open”
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To print to paper, open the file in Adobe or BlueBeam and print from there. 

7th Print to File

8th Save the file in the Project Folder
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4.7.3 Using Print Organizer for PDF Creation of Multiple DGN’s

To PDF your plan sheet set DGN files, follow these steps:

1st Select File

2nd Select 
Print

3rd Select Print 
Organizer
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4th Select “Add folder to set”

5th Edit folder name

6th Select “Add files to set”
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7th Add files to print

8th add the SMU print style
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9th Select the SMU_PRINT and OK

10th Select “OK”
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11th Select the 
dgn’s to print

12th Select “Print”

13th Set the destination 
to save the pdf’s

14th Select “OK”
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CHAPTER 5

3D MODEL CREATION

5.1 GENERAL 

Prior to starting a 3D model, make sure the Level of Development is understood. 

The final structure 3D model DGN organization needs to be determined early in the design 
process. The final model DGN file should display the final condition, but to reduce file 
sizes and risk of file corruption multiple structure DGN models may be required to get to 
the final condition. 

When determining the number of 3D model DGNs required, consider what the construction 
sequence and final 2D plan sheets will look like.  

5.1.1 Simple Models

Simple structure models can be created all in one DGN. These structures are often single to 
three span structures or culverts with off-site detours or new alignment structures not 
requiring any construction staging/phasing sequences. The Bridge Wizard is typically used 
to create these models.    

5.1.2 Complex Models

Complex structure models, either due to construction sequencing and/or structure type 
and/or size, require the final model DGN to be a container file. Container files encompass 
referenced DGNs that make up parts of the final model. Depending on the complexity of 
the structure being modeled, the container file can be made up of the following types of 
individual DGN models.

Less Complex Model DGNs

• Construction staging sequences of proposed structure
• Sequencing existing structure removal used as on-site detour 

More Complex Model DGNs

• Can include items listed under less complex model DGNs 
• Bridge Elements:

• Deck by Span
• Girders by Span
• End Bents
• Bents 
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5.2 3D MODEL FILE BASICS

5.2.1 Bridge Templates

Copy the SMU Bridge Templates out of the workspace and into the project WorkSet folder 
to enable customization of templates to meet project specifics. 

The SMU Bridge Templates are found under the NCDOT Workspace

Configuration_2024 > Organization-Civil > NCDOT > OpenBridge Modeler > Bridge 
Templates
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5.2.2 File Workflow

Create the model DGN file following the guidelines in Chapter 2. For 3D drawing creation, 
set OBD to the “OpenBridge Modeler” Workflow. 

5.2.3 Referencing Files

Creating the 3D structure model starts with referencing the geometry (Alignment 
(rdy_alg.dgn), Alternates (rdy_alt.dgn) for NCDOT) and Terrain (rdy_etm.dgn for 
NCDOT) files. If you are using an older project, see Chapter 1 to incorporate those files. 

1st Select “References” icon

2nd Select “Tools” and 
“Attach”
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3rd Find and select the alignment and terrain files 
and open them
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4th Set references to “Coincident-World” 
and scale to 1”=50’ 

5th Fit your view in both View 1 and View 2 
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5.3 3D MODEL BY ELEMENTS

For 3D model the Design Model will be used to create the proposed or existing structure 
elements in a 3D view at full scale (1:1) in their correct geospatial locations. Create all 
elements at their true dimensions. 

5.3.1 Adding A Bridge 

After referencing the alignment and terrain files into the bridge model dgn, use the 
following steps to add a bridge. If multiple bridges are present on the project, create 
separate dgn files and reference the alignment for each structure. 

1st Use the “Add Bridge” icon 

2nd Fill in your Structure ID in the 
Description and Name boxes and select 
the bridge type and feature definitions 
from the drop downs 
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5.3.2 Adding Supportlines 

After adding a bridge, use the following steps to add the end bent and bent supportlines. 
Supportlines will also need to be placed at the begin approach slab and end approach slab 
stations to add an approach slab deck.   

3rd Use the curser to select the 
alignment where the bridge is to be 
placed, click on the alignment…then 
data point off the alignment to select it.

1st Use the “Place Multi” SupportLine tool 
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Note: The “Length” in this box is the length of the SupportLine, so if you have a wide bridge make 
sure the length is long enough to preject beyond your bridge model.  Also OBD uses the skew angle 
as ahead and to the left as a negative value, unlike SMU that does ahead and to the right.    

2nd Input your bridges’ skew angle, start 
and end bridge stations, number of 
supportlines (note each end bent and 
bent has a supporline)

3rd Select the alignment near the start 
station, then near the end station. 

4th Verify the stations, skew angles, and 
span lengths
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5.3.3 Adding the Deck

After placing your supportlines, use the following steps to place the deck. There can be 
different deck templates used or multiple placements of the same template to create a 
bridge. An example of where multiple placements might be used is when including the 
approach slabs in your model you would place it from the begin approach slab supportline 
to the end bent 1 supportline and then the bridge deck would go from end bent 1 support 
line to end bent 2 supportline. 

1st Select the place the deck 
tool

2nd Select the correct “Template” and 
“Feature Definition” for your bridge. 
Change the “Deck Material” to 
Reinforced Concrete Deck Slab for the 
bridge deck and Bridge Approach 
Slabs for the approach slabs to match 
NCDOT Pay Items 

3rd Select the first support line, then the last support 
line for which the deck selected is to be placed
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5.3.4 Adding the Beam Layout

After adding the deck, use the following steps to place the bridge’s beam layout. Be sure to 
follow the Design Manual for overhang and beam spacing requirements. 

Note: the first and last beam spacing is the distance from the edge of deck and the last 
beam’s spacing is a negative value.  

1st Select the “Place Beam Layout” tool 

2nd Select the first support line, then the 
last support line of your bridge 

3rd Enter beam spacings and bearing 
offsets from supportlines for each span 
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5.3.5 Adding the Beams

Once the beam layout is placed, use the following steps to attach the beam types. 

1st Select the place beam tool

2nd Select the beam layout placed for 
your bridge 

3rd Select the beam template and correct NCDOT Pay 
Item material for the beam template selected
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5.3.6 Adding Diaphragms

Once the beam layout is placed, use the following steps to attach the diaphragms. 

1st Select the place diaphragm tool

2nd Select the “+” symbol to add as many diaphragms as 
needed for the span and edit their locations
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5.3.7 Adding Bents

Once the superstructre is placed, use the following steps to place the bents. 

1st Select the place pier tool

2nd Select the supportlines to place 
similar bents templates

3rd Select the correct “Template” and 
“Feature Definition” for your bridge. 
Change the “Cap Material” to Class A 
or AA for the bridge deck and Bent 
w/… to match NCDOT Pay Items 
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5.3.8 Adding End Bents

To place the end bents, use the following steps:

1st Select the place abutment tool

3rd Select the supportlines to place 
similar end bent templates

2nd Select the correct “Template” and 
“Feature Definition” for your bridge. 
Change the “Cap, Column, Footing and 
Pile Material” to Class A, AA, etc. and 
End Bent w/…  to match NCDOT Pay 
Items 

napierce
Stamp



NCDOT STRUCTURES MANAGEMENT OPENBRIDGE MANUAL CHAPTER 5
______________________________________________________________3D MODEL CREATION

5–16

5.3.9 Adding Wing Walls

To place the wing walls, use the following tool:

1st Select the place wing walls tool

2nd Select the correct “Template” and 
“Feature Definition” for your bridge. 
Change the “Wingwall Material” to 
Class A or AA for the bridge deck and 
Wingwall for the approach slabs to 
match NCDOT Pay Items 

3rd Select the end bents to place the 
wings

Note wing walls can be placed at skews 
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5.3.10 Adding Bearings

To place bearings, use the following tool:

1st Select the place bearings tool

2nd Select the correct “Template” and “Feature 
Definition” for your bridge. Change the 
“Bearing Material” to Elastomeric Bearing, 
Etc. for the bridge deck and Elastomeric 
Bearings to match NCDOT Pay Items 
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5.3.11 Adding Barrier Rails

To place the barrier rails, use the following tool, once for the left rail and again for the 
right:

1st Select the place barriers tool

2nd Select the correct “Template” and 
“Feature Definition” for your bridge. 
Change the “Barrier Material” to 
Concrete Barrier Rail, Etc. for the 
bridge deck and Concrete Barrier Rail 
for the approach slabs to match 
NCDOT Pay Items 
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3rd Select the structure, then data point 
off

4th Click on “select alignment” then 
click on the alignment of the structure, 
then click on “select guideline from list” 
and select the point which to place the 
rail on the deck…..repeat for other rail
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5.3.12 Adding Approach slabs

To place approach slabs in the model, add a single span bridge at the beginning of the 
bridge and the end of the bridge using the steps found in 6.1.2 through 6.1.4.  

or using the “bridge wizard” as found in section 6.2

  

Note: once the bridge is placed with the bridge wizard, use the edit model techniques found 
in section 6.3 to DELETE the abutments placed in the model. 

Enter “Begin/End App Slab” for 
bridge name, “RC Slab” for bridge 
type, select alignment, enter the start 
station, select deck template, enter the 
approach slab length for span, leave 
the abutment and pier templates as 
defaulted, select the appropriate left 
and right curbs for barrier templates

Enter “Begin/End App Slab” for bridge 
name, “RC Slab” for bridge type, select 
alignment, then follow the steps in 
section 6.1.2-6.1.4 and 6.1.12.
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5.4 3D MODEL WITH THE BRIDGE WIZARD

A quick way to place a 3D bridge model is using the bridge wizard.  Here are the steps. 

1st Attach required reference files as covered in Section 6.1.1

2nd Click on the “Bridge Wizard” icon 

3rd Enter the bridge name, select the 
bridge type, select the alignment 
which the bridge is to be placed on, 
enter the bridge start station (work 
point 1 station), select the deck 
template to be used, enter the span 
arrangements, the skew, number and 
spacing of beams, and select the 
templates to be used for the beams, 
abutment, piers, left and right barrier 
rails

NOTE: Span lengths and Beam 
Spacing are entered as feet:inches, 
so 6’-3 ½” beam spacing would be 
6:3.5. Span lengths are also 
separated by a space between them.  
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The model should be built in your DGN, but bearings will need to be edited to display the 
correct type and dimensions and wing walls will still need to be added. The model will also 
need properties edited to display the correct material properties when reports are generated. 
If multiple Element Templates need to be changed, rather than editing each element, it may 
be easier to delete the existing 3D bridge model and start over with the Bridge Wizard. To 
quickly delete the existing bridge, use the Select All button to highlight the bridge and then 
hit Delete.

4th Select the “Materials” tab and select 
the pay items that match the elements. 
Once completed, go back the 
“Geometry” tab and click “OK.”
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5.5 EDITING 3D ELEMENT TEMPLATES

If the Element Templates provided in the workspace are not adequate for the bridge being 
designed, the User may copy and edit the Element Templates before creating a structure as 
follows. 

  
Documents\Administration\WorkspaceGroups\NCDOTWorkspaces\Configuration_2023\W
orkSpaces\DOT-USNorth Carolina\Roles\NCDOT_Structures\Standards\Bridge Templates\

1st Go to the following folder SMU workspace in ProjectWise 

2nd Copy all the Template “.xml” files
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3rd Paste the Template “.xml” files in the project Bridge Templates folder

4th Edit the appropriate Templates using the Libraries tools
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5.6 EDITING A 3D MODEL

Changes happen in bridge design, to edit an existing model use the steps for the elements 
below.  For each element listed below, the following steps are required:

5.6.1 Editing the Bridge Deck

The bridge deck can be edited to change the template (super elevation left or right, or 
normal crown) or to edit the template constraints (left and right widths) and material type.

1st Select the element to be edited

2nd Click on the “properties” icon in the 
pop-up 

To change the template, click here

To edit the deck widths, click here

Edit deck material to NCDOT Pay 
Items

To edit the feature definition, click here
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To edit the deck widths, check “active” and then 
the “+” to edit begin and end width…do this for 
both left and/or right widths.
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5.6.2 Editing the Beam Layout

Beam Layout controls the number of beams, beam spacing and beam lengths

Note: The first and last beam spacing is the distance from the outside edge of the deck and 
the last beam’s spacing should be negative from the right outside edge of deck. 

To edit the beam layout, click here

Edit the number of beams here

Edit beam spacing and end of beams
Select span to be edited
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5.6.3 Editing the Beam Definitions

Editing the beam definitions allows changing beam types and material

Edit beam definition here

Edit beam type and material for each beam defined in 
the beam layout

Edit haunch depth

To edit the feature definition, click here
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5.6.4 Editing the End Bent 

End Bents properties can be edited for material types, elevation constraints and template 
properties such as cap dimensions, pile type/size and pattern.

Edit material types

Edit template dimensions

Edit elevation constraints

Edit cap and cheek wall dimensions as well as pile type and pattern

To edit the feature definition, click here
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5.6.5 Editing the Bent 

Bent properties can be edited for material types, elevation constraints and template 
properties, such as cap dimensions, column/pile type and size and pattern.

Edit material types

Edit elevation constraints

Edit template dimensions

Edit cap, cheek wall, columns, struts, footings, and piles properties 
such as dimensions, types and patterns

To edit the feature definition, click here
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5.6.6 Editing Barrier Rails

Barrier rail properties can be edited for start and end station offsets, template orientation, 
horizontal and vertical offsets, rail template, variable constraints, point control, point 
control path, feature definitions and material type. 

Edit start and end offsets if rails 
don’t go full length of deck

Edit offsets if rails are offset 
horizontally or vertically

Change rail template

Edit variable constraints

Edit material type to NCDOT Pay 
Item

Edit point control and point control 
path if barrier rail is to be placed on 
a different location than default 
edge of deck 

To edit the feature definition, click here
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5.6.7 Editing Bearings

Bearing properties can be edited for cap steps, offsets from supportline, orientation, type, 
skew angle, dimensions, if it has a bridge seat or not and its dimensions, if it has a plate/pad 
and its dimensions and the material properties. 

Edit offsets based on distance 
from the supportline

Edit material types to NCDOT Pay 
Item

Edit bearing orientation, type and 
dimensions

Edit bearing seats orientation, type 
and dimensions

To edit the feature definition, click here
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5.6.8 Editing Wing Walls

Editing wing wall properties can be edited to change the vertical offset, alignment with 
abutment, transverse offset, skew angle, template and material properties. 

Edit material types to NCDOT Pay 
Item

Edit the Wing Wall Template

Edit the wing wall dimensions and the piles

To edit the feature definition, click here
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5.7 ITEM TYPES

Once the 3D model has been generated, Item Types should be attached to the various 
elements to convey metadata to be shared with various Stakeholders of the structure model.  

5.7.1 Attaching Item Types

The following steps should be followed to attach Item Types:

Below is a view of the 3D model before any element is selected. There are no properties 
displayed until an element is selected.

Under the OpenBridge Modeler workflow, go to Utilites tab and find Item Types Group on the 
ribbon. 

Click on the Attach Item icon
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After clicking on the Attach Item icon, the Attach Item dialog box below will appear. Select the 
appropriate toggle for the Element to be attached.

For this example, the Deck Item Types will be 
selected and attached. 
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Use the Element Selection tool to select the Element to attach the Item Type to (eg the Deck for this 
example). 
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5.7.2 Detaching Item Types

The following steps should be followed to detach Item Types:

Under the OpenBridge Modeler workflow, go to Utilites tab and find Item Types Group on 
the ribbon. 

 

Select the Item Type from the drop down and select the element that you want to detach 
items from. 

                                                                                                               

Click on the Detach Item icon
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CHAPTER 6

PRELIMINARY & GENERAL DRAWING CREATION

6.1 PRELIMINARY GENERAL DRAWING

Preliminary General Drawings (PGD) depict the basic layout of the proposed structure and 
involves the use reference files, such as the Hydraulics Units BSR file or the Roadway 
alignment file and cross section files. Reference Chapter 4 the NCDOT Structures 
Management Design Manual for guidance on requirements of a PGD.  

Direct copying roadway, hydraulics and survey information out of OpenRoad DGNs will 
result in the OpenBridge DGNs becoming read only after exiting the file.   

To generate the plan view and cross section drawings used in the PGD and General 
Drawing in OBD, a 3D Model DGN will need to be created using either proposed roadway 
alignment files or survey files of the existing alignment. This 3D Model DGN is where the 
3D bridge model will be housed and used to create the 2D plan sheets from. 

The following sections will walk through the process of setting up the 3D Model DGN with 
either a proposed roadway alignment files or survey files of an existing alignment to create 
a PGD and/or General Drawing.   

6.1.1 Creating the 3D Model File

Creating a 3D Model DGN to house the structure 3D model and referenced roadway 
alignment and/or survey files is the first step in generating a preliminary general drawing 
and/or general drawings. This DGN Model will be referenced into the PGDs and GDs.

**Note: In future workflows where a 3D structure model is required, this DGN is where the 
structure model will be created and referenced to create 2D plans.  

6.1.1.1 Using ORD Alignment Files

The following steps use an ORD Alignment file to produce a 3D model.  
Step 1

Once the structure Model DGN has been created, go to the Home tab > Primary ribbon > 
Attach Tools > References find and attach the proposed Alignment (ALG), Final Survey 
(FS) and ECTM files for the project as references. 

References
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Navigate to the project Alignment folder and attach the alignment DGN.  

Note: ORD DGN’s will produce a warning message about the WorkSet not being the same 
as the OBD WorkSet, click “OK” and continue.   

Click “Attach” 
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Make sure the referenced files are orientated to “Coincident-World” with “Live Nesting” at a depth 
of “99” to get all references of the roadway alignment, FS and ECTM files located in their correct 
location.

Step 2

After the reference files are attached and the views has been fit to the structure location. 
Then zoom to find the boundary of the terrain. 
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Step 3

Hover anywhere in the View 1 screen, click and hold the right mouse button, when the 
menu pops up View Control > 3 Views Plan/Profile/3D

With Element Selection 
tool click on terrain model 

border until the ribbon 
opens

Select the “Set Active 
Terrain Model” icon

>View Control>3 
Views Plan/Profile/3D 
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Click “OK” 

In View 1, click on the 
alignment 

Then click in View 4 
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A multimodal view should be created

Move to Section 5.1.2 to create the PGD/GD plan and profile DGN. 

6.1.1.2 Using v8/GEOPAK Survey Files

When no alignment files are available, the survey files can be used to create a plan and 
profile taking the following steps. 

Step 1

Once the structure Model DGN has been created, go to the Home tab > Primary ribbon > 
Attach Tools > References find and attach the proposed alignment and/or FS and DTM 
files for the project as references. Make sure the referenced files are orientated to 
“Coincident-World” with “Live Nesting” at a depth of “99” to get all references of the 
roadway alignment, FS and DTM files located in their correct location. 
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Then, Home tab > Bridge Setup ribbon > Import Tool > Geometry import the gpk file 
(geometry).  

Select all the alignment information needed for the bridge location. Assign linear features 
from the NCDOT Features. 
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Next, Home tab > Bridge Setup ribbon > Import Tool > Terrain to import the tin files 
(terrain).  

Assign feature definitions from the NCDOT Existing list, and select to see triangles and/or 
contours when the terrain is displayed. Note they can be turned off later if need be.  

Step 2

After the reference files are attached and the views has been fit to the structure location. 

Hover over the existing alignment created by L&S in the View 1 (plan view) to determine if 
there is an active profile line. In the image below, there is no active profile established for 
the existing alignment. 

If there is an active alignment, skip the following steps and go to Section 5.1.2.
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Step 3

To create an alignment, Civil tab > Horizontal tools > Offsets and Tapers tool > Single 
Offset Entire Element

Before you click on the surveyed centerline of structure, set the parameters as follows:

• Offset: 0:0 (meaning no offset from the existing alignment element L&S created)

• Feature Definition: “Existing-Exist_ALG_Centerline” 

• Name: Match L&S’s name
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Once parameters are set…in the View 1 (plan view) window, click on the L&S alignment 
to select it, and to set it. 

Step 4

To set the stations, Horizontal > Modify Start Station tool. 

Set parameters as follows:

• Start Distance: 0’0”

• Start Station: 10+00.00

• Distance: 0’0” 

Then select the alignment in the plan view and follow the prompts, click to accept. 
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Step 5

Hover anywhere in the View 1 screen, click and hold the right mouse button, when the 
menu pops up View Control > 3 Views Plan/Profile/3D
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Select OK to create a dynamic profile view. 

In View 1, click on the created alignment and then move your curser to View 4 and click. 

The profile along the alignment should appear in the View 4 window.  

If it does not appear, zoom out in View 1 and activate the terrain file by finding the survey 
boundary line (the outline of the survey) and hovering over it until the property’s icon 
toolbox pops up. Select the second icon “Set Active Terrain Model”. 

Go back to View 4 and click the “Fit View” icon and the profile should appear. 
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Step 6

To add a vertical alignment, Complex Geometry > Profile Complex By PI tool

Set parameters as follows:

• Feature Definition: Existing > Existing_ALG_Centerline

• Name: match what was used in the Horizontal Offset and Tapers tool. 

Then, use the tool in View 4 to click on points along the existing profile and create a 
vertical alignment. 
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Now, set the newly created alignment as “Active” by selecting it and move off and back on 
the line until the tool bar pops up. Once the menu bar appears, select the second icon Set As 
Active Profile.

6.1.1.3 Using ORD Survey Files

When no alignment files are available, the survey files can be used to create a plan and 
profile taking the following steps. 

Step 1

Once the structure Model DGN has been created, Home tab > Primary ribbon > Attach 
Tools > References find and attach the roadway alignment file ALG, and/or survey files FS 
and ECTM for the project as references. Make sure the referenced files are orientated to 
“Coincident-World” with “Live Nesting” at a depth of “99” to get all references of the 
ALG, FS and ECTM files located in their correct location. 

Step 2

After the reference files are attached and the views has been fit to the structure location. 
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Hover over the existing alignment created by L&S in the View 1 (plan view) to determine if 
there is an active profile line. In the image below, there is no active profile established for 
the existing alignment. 

If there is an active alignment profile from the ALG file, skip the following steps and go to 
Section 5.7.2.

Step 3

To create an alignment, Civil tab > Horizontal tools > Offsets and Tapers tool > Single 
Offset Entire Element

Before you click on the surveyed centerline of structure, set the parameters as follows:

• Offset: 0:0 (meaning no offset from the existing alignment element L&S created)

• Feature Definition: “Existing-Exist_ALG_Centerline” 

• Name: Match L&S’s name
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In View 1 (plan view), click on the L&S alignment to select it, and to set it. 

Step 4

To set the stations, Horizontal > Modify Start Station tool. 
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Set parameters as follows:

• Start Distance: 0’0”

• Start Station: 10+00.00

• Distance: 0’0” 

Then select the alignment in the plan view and follow the prompts, click to accept. 

Step 5

Hover anywhere in the View 1 screen, click and hold the right mouse button, when the 
menu pops up View Control > 3 Views Plan/Profile/3D
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Select OK to create a dynamic profile view. 

In View 1, click on the created alignment and then move your curser to View 4 and click. 

The profile along the alignment should appear in the View 4 window.  

If it does not appear, zoom out in View 1 and activate the terrain file by finding the survey 
boundary line (the outline of the survey) and hovering over it until the property’s icon 
toolbox pops up. Select the second icon “Set Active Terrain Model”. 

Go back to View 4 and click the “Fit View” icon and the profile should appear. 
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Step 6

To add a vertical alignment, Complex Geometry > Profile Complex By PI tool

Set parameters as follows:

• Feature Definition: Existing > Existing_ALG_Centerline

• Name: match what was used in the Horizontal Offset and Tapers tool. 

Then, use the tool in View 4 to click on points along the profile and create a vertical 
alignment. 
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Now, set the newly created alignment as “Active” by selecting it and move off and back on 
the line until the tool bar pops up. Once the tool bar appears, select the second icon Set As 
Active Profile.

6.1.2 Creating A Plan and Profile Plan Sheet 

After the 3D Model DGN has been completed, create the DGN file for the PGD and/or GD 
to create the plan and profile views.  

Once the DGN is created, go to the Home tab > Primary ribbon > Attach Tools > 
References and reference in the newly created Existing 3D Alignment Model DGN.  

Once referenced, in View 1: right click and hold the right mouse button View Control > 2 
Views Plan/Profile   
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Select OK to create a dynamic profile view. 

In View 1, click on the alignment and then move your curser to View 4 and click. 

The profile along the alignment should appear in the View 4 window.  

6.1.2.1 Creating the Plan View 

In the View 1 window, select the Place Named Boundary tool > Civil Plan.
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Select the following:

• Drawing Seed:  Design (or PRR) Dual Plan Profile-PLAN

• Detail Scale: select a scale that will encompass the structure in the plan view. 

Tip: change the detail scale and check the length value compared to the bridge 
length, the length should be long enough to include the entire bridge, the approach 
slabs, plus some approach roadway on each end of the bridge. 

• Boundary Chords: set the boundary chords to 1 to place only one boundary or the 
minimum number of boundaries required to fit the entire bridge to look correct on a 
plan sheet. 

• Create Drawing: UNCHECKED

To place the plan sheet in View 1, select the alignment ahead of the bridge. The outline of 
the plan sheet should appear, if the box does not encompass the entire bridge and 
approaches as desired right click to cancel the placement. If the outline of the plan sheet 
encompasses the desired view, click ahead station to place it. Take note of the detail scale 
selected, it will be needed in further steps. 
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Note the Place Named Boundary tool might close during this step, reopen it to move to the 
Civil Profile tool.  

Annotating The Plan View

To use the Civil Labeler tool to annotate the plan view, go to the Default Design Model and 
add workpoints to the alignment using the steps found in Section 3.8.2.1.

In the Plan View Drawing Model, use the workpoints placed to draft the 2D layout of the 
substructure elements needed for the plan view.   

In the Plan View Drawing Model, use the Civil Labeler tool to annotate the workpoint 
stations by going to Reports and Drawings > Civil Labeler 
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Select the alignment, then the stations where the callout is to be placed. 
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6.1.2.2 Creating the Profile View 

In View 4 window, select the Place Named Boundary tool > Civil Profile. 

Select the following:

• Drawing Seed: Design or PRR Dual Plan Profile-PROFILE, 

• Detail Scale: set the scale to match the plan view scale.

• Method: From Plan Group, this will place the profile box in the same place as the 
plan view box placed earlier. 

• Select the “Create Drawing” box. 

In View 4, click on the alignment to place the box. Note the box should appear in the same 
stations as where the plan view box was placed. 
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Once the box is placed, the following tool box will open up:

It is important to make sure all the scales match before clicking “OK”. 

See step below
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Annotate the Profile Drawing Model

In the bottom left of the screen, select the Profile Drawing Model. 

In the Profile Drawing Model, use the elevations and stations automatically placed to draft 
the 2D elevation layout of the substructure elements and slope protection needed for the 
profile view.   

**Note: In the future, the Rip Rap layout will be provided by the Hydraulics model. 

To label elevations, go to Reports and Drawings > Civil Labeler 
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Use the SMU Profile Existing Elevation tool.

Select the existing profile line, then select the locations and place elevation labels as 
needed.   

Use the Roadway Civil Labeler tools to get horizontal and vertical curve data on the plan 
sheet. 
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6.2 GENERAL DRAWING SHEETS

The process in the above section for creating the Preliminary General Drawing (PGD) 
should be used to create the General Drawing, following the guidelines in Chapter 5 of the 
NCDOT Structures Management Design Manual for differences in content requirements. 

6.2.1 Foundation Layout Sheet

After the 3D Model DGN has been completed, create the DGN file for the Foundation 
Layout.  

In the Foundation Layout DGN, go to the Home tab > Primary ribbon > Attach Tools > 
References find and attach the 3D Model DGN files for the project as a reference. 

Once the 3D Model DGN is attached, close View 2, and in the View 1 plan view, add 
workpoints to the alignment using the steps found in Section 3.8.2.1 if they are not already 
on the referenced 3D Model. Turn off any references and levels not needed.  

Use the workpoints placed to locate and draw the foundations 1:1 in their geospatially 
correct locations.   

To create the Drawing and Sheet models, in the View 1 window, select the Place Named 
Boundary tool > Civil Plan.

Select the following:

• Drawing Seed:  Design (or PRR) Standard View

• Detail Scale: select a scale that will encompass the structure in the plan view. 
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Tip: change the detail scale and check the length value compared to the bridge 
length, the length should be long enough to include the entire bridge, the approach 
slabs, plus some approach roadway on each end of the bridge. 

• Boundary Chords: set the boundary chords to 1 to place only one boundary or the 
minimum number of boundaries required to fit the entire bridge to look correct on a 
plan sheet. 

• Create Drawing: CHECKED

To place the plan sheet in View 1, select the alignment ahead of the bridge. The outline of 
the plan sheet should appear, if the box does not encompass the entire bridge and 
approaches as desired right click to cancel the placement. If the outline of the plan sheet 
encompasses the desired view, click ahead station to place it. Take note of the detail scale 
selected, it will be needed in further steps. 

Note the Place Named Boundary tool might not open during this step, to open it click again 
within the boundary box.  
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Note the plan view might generate larger than wanted onto the plan sheet, the size can be 
rescaled using the reference tool box. 

Use the Drawing Model to annotate the drawing. Notes are placed in the Sheet Model. 
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6.2.2 Long Chord Layout Sheet

After the 3D Model DGN has been completed, create the DGN file for the Foundation 
Layout.  

In the Foundation Layout DGN, go to the Home tab > Primary ribbon > Attach Tools > 
References find and attach the 3D Model DGN files for the project as a reference. 

Once the 3D Model DGN is attached, close View 2, and in the View 1 plan view, add 
workpoints to the alignment using the steps found in Section 3.8.2.1 if they are not already 
on the referenced 3D Model. Turn off any references and levels not needed.  

Use the workpoints placed to locate and draw the long & short chords at 1:1 in their 
geospatially correct locations.   

To create the Drawing and Sheet models, in the View 1 window, select the Place Named 
Boundary tool > Civil Plan.

Select the following:

• Drawing Seed:  Design (or PRR) Standard View

• Detail Scale: select a scale that will encompass the structure in the plan view. 

Tip: change the detail scale and check the length value compared to the bridge 
length, the length should be long enough to include the entire bridge, the approach 
slabs, plus some approach roadway on each end of the bridge. 

• Boundary Chords: set the boundary chords to 1 to place only one boundary or the 
minimum number of boundaries required to fit the entire bridge to look correct on a 
plan sheet. 
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• Create Drawing: CHECKED

To place the plan sheet in View 1, select the alignment ahead of the bridge. The outline of 
the plan sheet should appear, if the box does not encompass the entire bridge and 
approaches as desired right click to cancel the placement. If the outline of the plan sheet 
encompasses the desired view, click ahead station to place it. Take note of the detail scale 
selected, it will be needed in further steps. 

Note the Place Named Boundary tool might not open during this step, to open it click again 
within the boundary box.  
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Note the plan view might generate larger than wanted onto the plan sheet, the size can be 
rescaled using the reference tool box. 

Use the Drawing Model to annotate the drawing. Notes are placed in the Sheet Model. 
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6.2.3 Location Sketch/Total Bill of Material Sheet

For location sketch and Total Bill of Material sheet requirements, see the guidelines in 
Chapter 5 of the NCDOT Structures Management Design Manual. 

6.2.3.1 Location Sketch

Design

After the 3D Model DGN has been completed, create the DGN file for the Location Sketch.  

In the Location Sketch DGN, go to the Home tab > Primary ribbon > Attach Tools > 
References find and attach the 3D Model DGN files for the project as a reference. 

To create the Drawing and Sheet models, in the View 1 window, select the Place Named 
Boundary tool > Civil Plan.

Select the following:

• Drawing Seed:  Design (or PRR) Standard View

• Detail Scale: select a scale that will encompass the structure in the plan view. 

Tip: change the detail scale and check the length value compared to the bridge 
length, the length should be long enough to include the entire bridge, the approach 
slabs, plus some approach roadway on each end of the bridge. 

• Boundary Chords: set the boundary chords to 1 to place only one boundary or the 
minimum number of boundaries required to fit the entire bridge to look correct on a 
plan sheet. 
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• Create Drawing: CHECKED

To place the plan sheet in View 1, select the alignment ahead of the bridge. The outline of 
the plan sheet should appear, if the box does not encompass the entire bridge and 
approaches as desired right click to cancel the placement. If the outline of the plan sheet 
encompasses the desired view, click ahead station to place it. Take note of the detail scale 
selected, it will be needed in further steps. 

Note the Place Named Boundary tool might not open during this step, to open it click again 
within the boundary box.  
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Note the location sketch might generate larger than wanted onto the plan sheet, the size can 
be rescaled using the reference tool box. Be sure to update the drawing scale in the Drawing 
Model to match the scale the reference in the Sheet Model is set to. 
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To get the Benchmark, go to the project folder on SharePoint, under the Location and 
Surveys folder Survey Controls subfolder, look for the Baseline or Control Sheets PDF or 
.txt files. These documents contain the survey data, including the Benchmarks (BM).  

To place a Total Bill of Material table on the sheet, see Section 5.2.3.2 below. 

Preservation

Preservation projects often don’t have either Roadway or survey files to reference in the 
existing bridge sounding area. To get a location sketch and provide enough information to 
help the Contractor see what the surrounding conditions look like at the bridge, use 
NCDOT’s GO!NC map viewer website with a hybrid view showing both road labels and 
satellite imagery. Take a clip of the bridge and surrounding image creating a .jpg file to be 
referenced. 

Use the Raster Manager tool to insert the .jgp image into the sheet model. 

File > Attach > Raster

Raster Manager

https://ncdot.maps.arcgis.com/apps/mapviewer/index.html?webmap=aa6c8a51fc744618ae45c8b105cf7ff7
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  Locate the .jpg file created, click Open. 

Check Raster Attachment Options, and click Attach. 
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Move the Raster image as needed, the image can be selected allowing increasing or 
decreasing the size by selected and dragging the corners diagonally.  

Place text using the annotation tools. 

Provide the bridge coordinates using the Latitude and Longitudes from the structure 
inspection report. 

To place a Total Bill of Material table on the sheet, see Section 5.2.3.2 below. 

napierce
Stamp



NCDOT STRUCTURE MANAGEMENT OPENBRIDGE MANUAL CHAPTER 6
______________________________________________________________PGD & GD CREATION

6–41

6.2.3.2 Total Bill of Material

Insert a Total Bill of Material using the Place Table tool. 

Drawing Production > Tables > Place Table

Under the Seed dropdown, find the SMU_TBOM table seed 

Edit the required number of columns to the number of pay items plus one to include the 
component name. 

Place the table on the sheet border. 
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To edit the table, select it which will open up the excel format within the DGN. Edit as an 
excel table, use the excel tools on the Layout tab. 

Note the font will be set to correct style and levels, do not edit it. 
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6.3 GEOTECHNICAL FOUNDATION TABLE SHEETS

Geotech provides foundation recommendations in an Excel spreadsheet format where the 
data is included in tables on one single sheet or multiple sheets depending on the size of the 
structure. The purpose of this section is to show how to incorporate these tables into a DGN 
file to be included in the structure plan set. 

5.3.1 Foundation Tables Excel File

Once the Excel file has been received from GEU and saved in the project folder, open the 
file, to identify which table tab(s) have been used for the recommendations and will need to 
be incorporated into the DGN file.. Most likely it will look like the sheet below.

5.3.2 Turn Off the Gridlines

In the Excel file, go to the View menu, uncheck Gridlines so it doesn’t show when the 
spreadsheet is imported into OBD.
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5.3.3 Link Spreadsheet Into The OBD File

Create or open the 4XX_###_TIP#_SMU_FT##_Sheet#_6digitStrID DGN file following 
Chapter 2. 

6.3.4 Setting Up the DGN

Once the DGN is created and saved in the correct folder, open the DGN and open the 
“Models” dialog box. 

Create a new sheet model and add the appropriate plan sheet border as described in Section 
5.4. 

5.3.5 Copy from The Excel File 

In the Excel file, select the tables from the spreadsheet.

Uncheck
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5.3.6 Paste From Clipboard Into OBD

In the sheet model, right click and hold to access the menu and select “Paste from 

Clipboard”. Then select from the pop-up menu to paste as “Link” and method “By 
Corners”.

Right click on the shaded area 
and copy (or  CTRL + C).

napierce
Stamp



NCDOT STRUCTURE MANAGEMENT OPENBRIDGE MANUAL CHAPTER 6
______________________________________________________________PGD & GD CREATION

6–47

Paste as shown below:

Right click and hold anywhere in the 
sheet to access this menu and choose 
to “Paste from Clipboard”.
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Make sure you select “Transparent Background”.

Place the tables by corners as shown below. 

Copied tables are now linked. 

Click to expand!

Try to place the block to 
fit within the plan sheet.
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5.3.7 Properties of the Linked Tables in OBD

Excel files linked in OBD will be live and can be updated to reflect any changes made in 
the original files. Follow the steps to update links in OBD:

From the Utilities menu, click the 
drop-down list of OLE. 
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This action will update the values (cells) of the spreadsheet, but won’t affect the properties 
or size of the linked tables. 

Click on “Update Links”.

Double click on the link border to open the linked Excel File.

napierce
Stamp



NCDOT STRUCTURE MANAGEMENT OPENBRIDGE MANUAL CHAPTER 6
______________________________________________________________PGD & GD CREATION

6–51

5.3.8 Multiple Links

You may link different tables or notes from separate spreadsheets on the same plan sheet.

Any part of the spreadsheet can be linked as a separate link on this plan sheet. Remember to 
add the needed Foundation Notes from the SMU Notes tab in OBD.
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5.3.9 Edit Link Properties

You may resize the tables either by adjusting the handles/borders or by changing the scale 
in properties as shown below:

 

If you forget to select Transparent Background, you may change that from properties by 
choosing YES for Transparent. 

Hover over the table border to 
access the properties menu. 

Update the scale to 1:1 or as 
deemed fit.

Use these handles 
to adjust the size.
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NOTE: To see the transparent background after changing the properties of the linked file, 
you may need to close the OBD file and reopen it.
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CHAPTER 7

PLAN SHEET CREATION

7.1 TITLE SHEET

A title sheet is used to provide project information including the project number, location, type of work, vicinity 
map, project map, project length, and roadway/traffic design data. A title sheet can be created one of two ways, 
either by referencing the Roadway title sheet or creating a new title sheet using the SMU title sheet cell. For 
required title sheet content, refer to Chapter 1 of the NCDOT Structures Management Design Manual.  

7.1.1 Roadway Title Sheet

Create a title sheet DGN following the file naming convention in Chapter 2. Once the DGN has been created, go to 
the Home tab > Primary ribbon > Attach Tools > References 

Find and attach the Roadway title sheet into the default model.   
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The WorkSet for the referenced file is not SMU’s, so click “OK” to continue. 

Set the orientation to “Coincident-World” and click “OK”
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Fit the view.

Use the Place Named Boundary tool to create the drawing and sheet models.

View tab > Named Boundaries ribbon > Place Named Boundary Tool > By 2 Points

 

Using an SMU Scratch Level, place a boundary by two points around the plan sheet.
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Create a Sheet Model.

In the sheet model, text and other non-relevant content can either be masked or levels turned off, new text can be 
placed in the drawing model as needed. 
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Right click > Turn Level Off by Element

Using the tool, then select elements to be turned off and replaced with what is needed for the structures portion of 
the project. 

Note copying the Roadway title sheet can lead to making the file read only.  

7.1.2 No Roadway Title Sheet

Some projects, such as a bridge preservation project or an in-kind timber bridge replacement project, don’t always 
have a roadway title sheet and need one created. 

Create a title sheet DGN following the file naming convention in Chapter 2. Once the DGN has been created, use 
the steps found in Section 3.7.1.3 to create a sheet model. 

The SMU Title Sheet is available as a cell. In the sheet model, go to the Annotate tab >  Cells ribbon > Place 
Active Cell tool > Active Cell 
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File >  SMU_Annotation cell library.
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Find the “Title Sheet” cell and place it within the ANCI-D sheet print border. 

Edit the placed title sheet as needed, note it might need to be dropped to edit.  

7.2 INDEX SHEET

Create an index sheet DGN following the file naming convention in Chapter 2. Once the DGN has been created, use 
the steps found in Section 3.7.1.3 to create a sheet model. 

The SMU Index Sheet is available as a cell. In the sheet model, go to the Annotate tab >  Cells ribbon > Place 
Active Cell tool > Active Cell 
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File >  SMU_Annotation cell library.
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Find the “Index Sheet” cell and place it within the ANCI-D sheet print border. 

Edit the placed index sheet as needed, note it might need to be dropped to edit.  
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7.3 SUPERSTRUCTURE SHEETS

Superstructure sheets include the typical section throughout the superstructure, plan of spans, bridge framing plan, 
girder/beam details, diaphragm details, expansion joint details, barrier rails details, and bearing detail sheets. For 
detailed guidance on what is required in those plan sheets, see Chapter 6 of the SMU Design Manual. 

Use SMU’s Standard Plans as appropriate, following the steps in Section 6.5. 

7.3.1 2D Drawings

Create a DGN for each superstructure plan sheet to be drawn following the file naming convention in Chapter 2. 
Once the DGN has been created, draw the superstructure elements full scale 1:1 in the Design (default) Model, and 
dimensioned in the Drawing Model, with final plan sheet assembly in the Sheet Model. 

Superstructure sheets will commonly use the “Design Plan Profile” or “PRR Plan Profile” SMU borders in the Sheet 
Model.  

Use the SMU Element Templates to match the corresponding line styles, weights, levels, features, and material 
properties to the elements being drawn.  

Once the elements are drawn in the Design Model, use the place named bound tool as follows to create the Drawing 
and Sheet Models. 

View > Named Boundaries > Place Named Boundary 
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Use the By 2 Points tool

Place the fence around the superstructure element to be placed on the plan sheet. 
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Create the Drawing Model and Sheet Model

Note: If a Sheet Model has already been 
created for the DGN, use the drop down to 
select the sheet model you want the drawing 
to appear on. 

The detail scale is auto generated trying to fit 
the fenced area into the pre-determined box 
on the SMU plan sheet. This can be adjusted 
later if need be.  
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The placed named boundary item can be moved and scaled up or down on the plan sheet using the References tool. 

Once the element is at the scale that works for the plan sheet, the element can be annotated in the Drawing Model. 
Note, set the drawing scale in the Drawing Model to the scale used for the placed named boundary in the Sheet 
Model. 

In the Drawing Model, detail reinforcing steel and annotate the drawing. 

In the Sheet Model, place notes using the SMU NOTES app and detail cells.
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7.3.2 3D Models to 2D Plans

Use the 3D model DGN created following the steps laid out in Chapter 7 to create a 3D structure model. Once the 
3D structure model has been created, a DGN will need to be created for each required 2D superstructure plan sheet. 

Typical Section

To create a 2D typical section view from the 3D model, use the Typical Section tool. 

Reports and Drawings > Drawings > Typical Section

Select the alignment
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Locate a section on the bridge for a good typical section slice

Create the Drawing Model and Sheet Model 
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The typical section can be moved and scaled up or down on the plan sheet using the References tool. 

Once the element is at the scale that works for the plan sheet, the element can be annotated in the Drawing Model. 
Note, set the drawing scale in the Drawing Model to the scale used for the placed named boundary in the Sheet 
Model. 
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In the Drawing Model, detail reinforcing steel and annotate the drawing. 

In the Sheet Model, place notes using the SMU NOTES app and detail cells.  
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7.4 SUBSTRUCTURE SHEETS

Substructure sheets detail end bent caps, bent caps, columns, piles, drilled piers, footings, pile caps, and wing walls.  
For detailed guidance on what is required in substructure plan sheets, see chapter 7 of the SMU Design Manual.  

Use SMU’s Standard Plans as appropriate, following the steps in Section 6.5. 

7.4.1 2D Drawings

Substructure elements should be drawn full scale 1:1 in the Design Model, and dimensioned in the Drawing Model, 
with final plan sheet assembly in the Sheet Model. Substructure sheets will commonly use the “Design Plan Profile” 
or “PRR Plan Profile” SMU borders in the Sheet Model. Use the SMU Element Templates to match the 
corresponding line styles, weights, levels, features, and material properties to the elements being drawn.  Use 
SMU’s Standard Plans as appropriate, following the steps in Section 5.12. 

Substructure sheets will commonly use the “Design Plan Profile” or “PRR Plan Profile” SMU borders in the Sheet 
Model.  

Use the SMU Element Templates to match the corresponding line styles, weights, levels, features, and material 
properties to the elements being drawn.  

Once the elements are drawn in the Design Model, use the place named bound tool as follows to create the Drawing 
and Sheet Models. 

View > Named Boundaries > Place Named Boundary 
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Use the By 2 Points tool

Place the fence around the substructure element to be placed on the plan sheet. 

Note: If a Sheet Model has already been 
created for the DGN, use the drop down to 
select the sheet model you want the drawing 
to appear on. 

The detail scale is auto generated trying to fit 
the fenced area into the pre-determined box 
on the SMU plan sheet. This can be adjusted 
later if need be.  
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The placed named boundary item can be moved and scaled up or down on the plan sheet using the References tool. 

 

Once the element is at the scale that works for the plan sheet, the element can be annotated in the Drawing Model. 
Note, set the drawing scale in the Drawing Model to the scale used for the placed named boundary in the Sheet 
Model. 
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In the Drawing Model, detail reinforcing steel and annotate the drawing. 

In the Sheet Model, place notes using the SMU NOTES app and detail cells.

7.4.2 3D Models to 2D Plans

Use the 3D model DGN created following the steps laid out in Chapter 7 to create a 3D structure model. Once the 
3D structure model has been created, a DGN will need to be created for each required 2D superstructure plan sheet. 

Reports and Drawings > Drawings > Substructure

 

Select the substructure item, and accept the selection. 
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The typical section can be moved and scaled up or down on the plan sheet using the References tool. 

Once the element is at the scale that works for the plan sheet, the element can be annotated in the Drawing Model. 
Note, set the drawing scale in the Drawing Model to the scale used for the placed named boundary in the Sheet 
Model. 

In the Drawing Model, detail reinforcing steel and annotate the drawing. 

In the Sheet Model, place notes using the SMU NOTES app and detail cells.
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7.5 SMU STANDARD DRAWINGS & PLANS

SMU Standard Drawings and Plans are available on the SMU website for external users and on the SMU server for 
internal users to download to the project folder. Once downloaded to the project folder, they can be referenced into 
the Sheet Model of the DGN.

Structure standard drawings and plans should be their own DGN files within the project, named according to 
Section 2.3, where they can be edited as needed. 

The Drawing Scale of the Sheet Model will need to be changed from “Full Size 1=1” to match the scale noted above 
the referenced drawing. 

At this point in time many of the standard drawings and plans contain outdated fonts and levels, SMU will update 
these features as standards are revised.  Users are not required to update standard drawing content to current 
workspace fonts and levels within the drawing’s field, only the title block content to match other plan sheets within 
a plan set.  Each standard drawing used should be its own DGN file set to the scale noted above the plan sheet.  

7.5.1.1 SMU Standards in the Default Model 

Older Standard Drawings and Plans could still have the required plan sheet in the Default Model of the DGN. To 
use those DGN’s, take the following steps. 

Create a DGN following the file naming convention in Chapter 2. Once the DGN has been created, create a Sheet 
Model as shown in Section 3.7.1.3. 

In the Sheet Model, go to the Home tab > Primary ribbon > Attach Tools > References 
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Find and attach the Standard Drawing/Plan sheet into the Sheet Model.  

The standard drawing might come into the Sheet Model at a different scale from the ANCI D sheet.  

Check the top of the referenced standard to find what the referenced drawing scale is. 

In the Sheet Model, update the drawing scale Utilities > Drawing Scale  to match the reference.  
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7.5.1.2 SMU Standards in the Sheet Model

Standard Drawing and Plan DGNs that have been updated to the OpenBridge DGN file format have the plan sheet 
in the Sheet Model of the DGN. To use these DGN’s, take the following steps.

Download the Standard Drawing and Plan DGN from the SMU website or server, save the file in the project folder 
and revise the DGN file name following the naming convention outlined in Chapter 2.  

In the Sheet Model, check References for default models turned on for other referenced models turned off. 

In the Sheet Model, edit the required fields in the Standard Drawing and Plan as necessary. 
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CHAPTER 8

QUALITY CONTROL & QUALITY ASSURANCE

8.1 2D FILE QUALITY CONTROL 

The Drafter of the 2D files needs to create PDF renditions of all DGN files.  PDF check 
plans should be stored in the Plans folder under the structure from which they were 
generated, along with what percentage review plans they are within the name and metadata.  
Files should then be assigned to the Checker for review through ProjectWise by the Drafter 
or a Supervisor.  

8.1.1 File Management 

The Checker should verify that each plan sheet is its own DGN file as well as each DGN 
file has the correct file name following the SMU naming conventions and assigned 
metadata. 

Checkers shall notify the Project Manager/Supervisor about files that are not following 
SMU policies for file management. 

8.1.2 PDF’s

2D PDF plans should continue to be checked for accuracy as to the structure’s design, 
AASHTO and NCDOT policies and specifications using electronic document review 
software, such as BlueBeam or Adobe Acrobat.  

8.1.3 DGN’s

2D DGN files should be assigned and checked at the same time as the PDF’s so that 
comments can be placed on the PDF plan sheet about that sheet’s DGN file. The Checker 
should create their own DGN file and reference the original DGN files in to review it. DGN 
files should be checked for correct use of SMU element templates, line styles, and 
annotation styles.  

Level Display Tool  

A quick way to see if the correct element templates have been used is to check the “Level 
Display” tool.  Using this tool, a Checker can quickly see if the levels used make sense for 
the DGN being checked.  For example, if checking an End Bent plan sheet does the 
“SMU_End Bent Cap Lines” level appear in the list as being used? 
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Element Selection Tool  

Another way to check a dgn for correct element template usage is to use the element 
selection tool. Select the Element Selection tool and hover over elements within the dgn to 
see what level they are on. Verify the levels match the element drawn. 

Select the “Level Display” tool

Check the “Used” Levels for use of 
appropriate levels for the element(s) 
drawn. Levels used in the file have a 
“dot” next to them, un-used do not. 
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Measurement Tools 

The measurement tools, under the “Analyze” tab, can be used inside the DGN to verify 
element dimensions. 
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8.2 3D MODEL QUALITY CONTROL

The first step in reviewing the 3D model is to know the level of detail (LOD) to which the 
model is supposed to detailed to. The next step is for the Drafter or Supervisor to create a 
copy of the model and name it 4XX_QC#_TIP#_SMU_BR#_MODEL_6digitStrID   and 
assign the file to the designated Checker.  If the structure is large or if the review is to be 
broken up into superstructure and substructure reviews, create multiple QC copies of the 
model changing the QC# in the name and assign the QC versions to the designated 
checkers. Checkers will need to check, but not limited to, the following items.

8.2.1 File Management 

The Checker should verify that the 3D model DGN follows the SMU naming conventions 
and has been assigned metadata. All 2D plans DGNs created from the 3D model should 
also follow the SMU naming convention and have metadata assigned. 

Checker shall notify the Project Manager/Supervisor about files that are not following SMU 
policies for file management.  

8.2.2 Bridge Layout

The structure layout QC is a macro check against the design, AASHTO and NCDOT 
policies and specifications.  The Checker will need to verify: 

• Support Line stations 

View 1 (plan view) shows the support line stations.

• Support Line skew angles 

Click on the support lines and clicking on the “Properties” icon. 
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• Horizontal Clearance clashes to roadways, rail roads, utilities, etc. 

• Vertical Clearance clashes to roadways, rail roads, etc.    

8.2.3 Bridge Deck

The Checker will use the steps in Sections 6.5.1 and 6.5.6 of this manual to review the 
bridge deck element properties using the same tools as editing them.  

The deck should be checked against the design for:

LOD 300

• Feature Definitions

• Deck Materials

Verify: 

• Deck width

• Deck thickness

• Haunch width

• Haunch thickness

• Left overhang width

• Right overhang width

• Left gutterline offset from proposed -L-

• Right gutterline offset from proposed -L- 

• Rail Section properties

• Left rail offset from left outside deck edge

• Right rail offset from right outside deck edge 
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LOD 350 (LOD 300 plus the following)

• Reinforcing steel size

• Reinforcing steel spacing/layout (includes clearances)

• Reinforcing steel bar lengths

• Reinforcing steel bar splices

LOD 400 (LOD 350 plus the following) 

• Prestressing strand sizes

• Prestressing strand spacing/layout

8.2.4 Bridge Superstructure

The Checker will use the steps in Sections 6.5.2, 6.5.3 and 6.5.7 of this manual to editing 
element properties as a way to review the superstructure elements. The superstructure 
elements should be checked against the design for:

LOD 300

• Girder section properties 

• Girder lengths 

• Girder end offsets/clearances

• Girder spacing

• Diaphragm locations

• Diaphragm section properties

• Bearing locations on girders 

• Bearing dimensions  

LOD 350 (LOD 300 plus the following)

• Girder reinforcing steel sizes

• Girder reinforcing steel spacing/layout (includes clearances)

• Girder reinforcing steel splice lengths

• Girder shear stud sizes

• Girder shear stud spacing

LOD 400 (LOD 300 plus the following) 

• Girder prestressing strand sizes

• Girder prestressing strand spacing/layout (includes clearances)
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8.2.5 Bridge Substructure

The Checker should use steps shown in Sections 6.5.4, 6.5.5 and 6.5.8 of this manual for 
editing substructure elements as a way to review the substructure elements. The 
substructure elements should be checked against the design for:

LOD 300

• Cap Dimensions

o Length

o Height

o Width

o Overhangs with Columns/Piles

o Bearing edge distances

• Bridge Seats

o Bearing edge distances

o Seat width

o Seat height 

o Seat Elevations

• Columns/Piles

o Size

o Spacing

o Lengths 

• Footings

o Spacing

o Lengths/Widths/Height 

• Elevations (top of cap, footings, pile tips, etc.) 

LOD 350 (LOD 300 plus the following)

• Caps/Bridge Seats/Columns/Piles/Footings Reinforcement

o Bar Sizes

o Bar Spacing/Layout (includes clearances)

o Bar Lengths

o Bar Splices

LOD 400 (LOD 300 plus the following) 
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• Caps/Bridge Seats/Columns/Piles/Footings Prestressing

o Bar Sizes

o Bar Spacing/Layout (includes clearances)

8.2.6 Reports

When checking 3D models, the Bridge Reporting tools should be used to verify the 
structure’s element properties such as quantities and elevations from the model.  The 
reporting tools can be found here:

Checkers should continue to use NCBDS, spreadsheets, and other tools that are currently 
used to verify structure designs, layouts, and quantities. 

8.2.6.1 Quantities Report

To generate a quantities report, go to Reports and Drawings > Bridge Reporting > 
Quantities Report

Select the parameters:

• Bridge: Active

• Unit: Active 

• Unit/cost data: Disable

Note: SMU will not be maintaining the cost data in the OBD library, only the pay 
items. 
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Click Submit once the parameters are selected to generate the report. 

Note that elements where materials were not assigned display “None” in the quantities 
report. 
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8.2.6.2 Item Type Reports

To generate an Item Type report, under the OpenBridge Modeler workflow and Utilities 
tab, find the Reports Icon on the ribbon.

To create a new category, find the add New Category icon on the ribbon.
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Give the new Category a name.

To add report definition, find the New report definition icon on the ribbon.
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